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Thank You!

Thank you for choosing ZipGenius, the truly free file compression utility for Windows™.

Please, read carefully this help file if you want to get the better experience from ZipGenius.

If you want to support this project, feel free to donate through PayPal.

If you paid to download and/or use ZipGenius, please report it so we could take action against this thief.

Created with the Personal Edition of HelpNDoc: Write eBooks for the Kindle

https://paypal.me/zipgenius
mailto:contact@zipgenius.com?subject=I paid to download ZipGenius
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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The answer to this question becomes as more obvious as time passes by and the Internet spreads

around the world: tomorrow way or working is just arrived. Today many people work and

collaborate through the Internet and they often need share projects and documents; nowadays,

this kind of stuff is a huge amount of bytes to transfer through the net and, even if broadband

networks are spreading quickly, transferring a big file may be a problem and it could represent a

loss of productivity. Compression programs allow to reduce the size of a file, as much as it is

possible, and work becomes faster and easier.

But everyone can take advantages from file compression: students can store their researches over

the Internet and bring them to school, or digital artists can share their pictures by using zip files.

Compressed files also may result useful when you need to backup your most important data, such

as system files, and ZipGenius has powerful backup features, so that you can quickly restore

lost data.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

ZipGenius (as you may understand) gives full control on zip files and archives similar to zip, plus it

can protect your zip files with a better encryption system than the one you normally activate by

adding files with password. CZIP file type can be read just by ZipGenius 1.4 or later, or by

program compliant with CZIP format.

Here are all the file types that ZipGenius can handle:

TYPE TREATED
AS COMPRESSION EXTRACTI

ON

External
program
required?

ZIP
CZIP

EXE (ZIP
SFX)

ZIP * * no

JAR
EAR
WAR
(Java

ARchives)

ZIP * * no

DSFZ ZIP * * no

BSZ
(BS Player

skin)
ZIP * * no

MSKIN ZIP * * no

https://www.helpndoc.com
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(Maxthon
skin)

CBZ ZIP * * no

PCV ZIP * * no

XPI
(Mozilla

extension)
ZIP * * no

SXW
SXI
SXC
SXD
STW
STD
STC
STI

SXG
SXM

(OpenOffice.
org 1.x

documents)

ZIP * * no

OOT

(OpenOffice.
org 2.x

documents)

ZIP * * no

TAR TAR

*, no file update

* no

TAR.GZ TAR * no

TAR.BZ2 TAR * no

TAZ TAR * no

TGZ TAR * no

ACE
EXE (ACE

SFX)
ACE no * no

RAR
R00
R01

EXE (RAR
SFX)

RAR no * no

CBR RAR no * no

7Z 7Z * * (*, included)
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ARJ ARJ no * *

CAB CAB *, no file update * no

LZH LZH * * *

LHA LZH * * *

SQX SQX * * no

YZ1 YZ1 * * no

RPM RPM *, no file update * no

ISO
NRG
CMI

ISO no * no

WAL
(WinAmp

Skin)
ZIP * * no

WMZ
(Windows

Media Player
SKin)

ZIP * * no

 

This software can handle ZIP files sized larger than 4 GB (ZIP64 format).

ZipGenius supports documents produced with LibreOffice/OpenOffice. Even if these are office

suites, the documents they produce are common zip files, which contain some XML file. Now you

can change the content of those XML file by extracting them with ZipGenius; moreover, you can

optimize these documents by extracting those XML files and compressing them back applying the

best compression level available.

Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

ARCHIVES HANDLING

· More than 20 archive types supported

Handles ZIP archives sized over 4 GB.

· OpenOffice.org/StarOffice handling and optimization capabilities

· 4 modes to view files icons

· 2 way to browse files: integral (as in WinZip) or through folder view

· 5 compression levels (storage + 4 compression levels)

· Brutal+UPX additional compression level for ZIP-like archives: it uses the power of UPX to

compress executable files like EXE, DLL, OCX.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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· Files list can be exported in 4 formats (HTML, CSV, XML, TXT)

· Can create self-extracting files (SFX) with advanced features, that can even launch a setup

procedure

· Smart Extract: extracts and organizes files

· History

· Can create Multivolume archives (Disk Spanning)

· Can repair damaged zip files, plus AutoTest

· Drag and drop supported

· Find files inside archives

· MultiOpen can make you handle more than archive at once

· 7-ZIP format supported

· Favorite folders

· Can install applications, themes for Windows XP and WinAmp/WMP skins temi e skin.

· File marker upon given criteria

· MD5 checksum control while TESTing an archive

INTERNET AND MOBILITY

· Can interoperate with PocketPCо mobile devices

· Can send archives through e-mail

· Can publish archives to Web

· FTPGenius XP (ftp client) - included in ZG Suite Edition setup only and also available as

separate download

· Supports UU/XX/MIME/BASE64 encoding techniques

USER INTERFACE

· User can choose that layout that fits his/her needings

· ZipGenius Starter: wizard-driven pre-configuration tool

· First Step Assistant

· Full Windows 98/ME/2000/XP/Server 2003 shell integration

· Customizable context menu

· High customization

· Explorer styled user interface, now with Common Task sidebar

· Menu items are grouped into sections

· Can show a grid in the files list

· Windows XP visual styles are supported



ZipGenius 6 Help

7 / 80

ADVANCED FEATURES AND MULTIMEDIA

· TWAIN devices supported (scanner and digital cameras) in order to import and compress

pictures

· Pictures preview

· Can install external compression programs

· ZG Update: automatic program update through the Internet

· Command line driven

· Cutter: a ZGTool to split large files in smaller parts

SAFETY AND PRIVACY

· 4 encryption algorithms (CZIP 2.1, Rijndael AES, Blowfish, Twofish)

· Can create self-locking and self-erasing CZIP files + self-decrypting archives (SDA) in .EXE

format

· Password Manager

· Backup features

· Can scan archives through an Antivirus program

· Suspicious files can be detected

· Various privacy settings

· Can create and show zip file SIGNATURE

Created with the Personal Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web
sites

ZipGenius development never stops (just some pause), so sometimes you may need to update

your copy of this program.

Update procedure is automatic: you have only to go to "HELP" menu and to click on "Search

for updates"; ZipGenius will try to connect to ZipGenius website, where it will check if you have

the latest version of ZG.

Privacy policy: no personal data is sent over the Internet. The software will point your default

web browser to a ZipGenius website page where a script will check just the version number sent

by the software.

If a newer version will be found, you will be allowed to download the update: this may be a file of

various sizes, because it could be just a simple patch or a whole new "zipgenius.exe" file.

Only administrators can update ZipGenius in Windows 2000, XP or later.

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Minimum requirements

· CPU Pentium 100 MHz
· 64 Mb RAM
· 512 Mb of free hard disk space
· Mouse
· Windows 98 / ME / XP / 2000 / Server 2003 / Vista
· Windows 95 and NT4 no longer supported

Suggested hardware

· CPU Pentium-class 200 MHz (Intel or AMD)
· 512 Mb RAM
· 8 GB of free hard disk space
· Mouse
· Internet class
· Windows 7 (at least)

Created with the Personal Edition of HelpNDoc: Easy EBook and documentation generator

System administrators usually have to install an application over a LAN with many machines

attached to that: that's why ZipGenius now offer the unattended setup feature.

Launching an unattended setup is really easy.

Click Start>Run and type the following syntax:

· zg6[std|sui].exe /silent

Where you have to specify if it's Standard ("std") or Suite ("sui") edition of ZipGenius. As example,

if you get ZipGenius 6 Suite, you will have to type:

zg6sui.exe /verysilent

Obviously, you can add this command to a batch file for larger system setup.

Created with the Personal Edition of HelpNDoc: Qt Help documentation made easy

ZipGenius user interface has evolved since 1997, when the very first release of ZipGenius

appeared, but always offering three toolbars full of commands; now ZipGenius shows a new

design inspired by Windows® XP, so even beginners can easily use this program. Commands are

now available in different places:

MAIN TOOLBAR

It shows main ZipGenius commands ("New", "Open", etc.).

https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com
https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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If you want to see buttons without labels, right-click on the toolbar and uncheck the "Show button

labels" item; if you want to see smaller icons in the toolbar, right-click on the toolbar and check

"Show smaller icons".

SIDEBAR

It was conceived to make easier ZipGenius usage, allowing access to many features through the

"Panels" button. Available panels in the sidebar are:

· Common Tasks

· Folder view

· History

· Find Files

You can hide the SideBar from "Tools" > "Layout" menu, just as you could do with the status

bar and the info bar.

Created with the Personal Edition of HelpNDoc: Full-featured Documentation generator

The Common Tasks panel is one of the most important new features in ZipGenius interface. It is

conceived to make easier working with ZipGenius, because it offers a "look and feel" similar to

Windows® Explorer.

All main commands were moved to this panel (and to the popup menu, also). Here you sill find

links to most used actions and they are grouped in several sub-panels, just as in Windows® XP.

These links are context-sensitive, so they appear/disappear under certain circumstances.

Sub panels are:

Common tasks

· New Archive: use it to create a new archive

· Open Archive: opens an existing archive

· Close Archive: closes current archive

· Scan and Zip: it starts the wizard to import pictures from a TWAIN source (see: Scan and

Zip page)

Archive Tasks

· Add file: it allows adding one or more files to current archive

· Add folder: it allows to add the content of a folder

· Extract files: this link starts files extraction

· Extract to CD-R/RW: this link can extract files to pre-burning folder of Windows XP, making

https://www.helpndoc.com
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them ready to be written to a CD-R/RW through CD burning capabilities of Windows XP

· Delete: deletes all or just the selected files from current archive

· Preview: this item allows to preview an archived file

· Rename archive: renames current archive

Other Tasks

· Print file list: send the file list to default printer

· Sign archive: puts your signature in current zip archive

· Export file list to html/xml/csv/txt: save files list in one of those formats

· Make SFX: this item can convert zip, lha, lzh, arj or 7z archive to .EXE

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

The First Step Assistant allows users that selected "NORMAL" layout to access the advanced

features of ZipGenius. In ZipGenius 6 the FSA has been transformed into a submenu attached to

the "HOME" button; if you are using "EXPERT" layout, it become visible once you switch to

"NORMAL". You will see then an arrow next to the Home button: click it to see all the actions

available at that moment, and click one item to begin the related action.

Not all the features are available at the same time: they are strictly related to the status of

ZipGenius (archive open or not, which kind of archive is open and so on).

Created with the Personal Edition of HelpNDoc: Free Qt Help documentation generator

Archives history keeps track of all archives you have used with ZipGenius: they are sorted by date

and you can reopen them with a click on their filename.

History list shows also the full path to each archive and how many times they have been read.

https://www.helpndoc.com/feature-tour/iphone-website-generation
https://www.helpndoc.com
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To grant better protection to your work, ZipGenius can encrypt the history file: click on

"Options">"Advanced settings" and open the "Safety and Privacy" page. Here you can check

the "Encrypt history file" option.

WARNING: each time you change this setting, the previous history file will be removed.
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Created with the Personal Edition of HelpNDoc: Free EPub producer

ZipGenius has been conceived to integrate with Windows® shell. When you associates archive

types to ZipGenius, you can enable shell extensions: tooltips (moving mouse pointer over a zip file

tells more about that file) and the context menu. To see this menu, you must right click on a file

and you will see ZipGenius items.

You can customize menu items from Options panel: click "Options" > "Advanced settings" and

go to "Shell Integration" page. Available items are:

Extract here

This command extracts files in the same folder of selected zip archive.

Publish to Web

Activates FTPGenius and transfers files to a FTP server.

Contents

The content of selected archive will appear in a new window.

https://www.helpndoc.com/create-epub-ebooks


ZipGenius 6 Help

13 / 80

Make EXE

Converts zip files to a self-extracting archive (SFX).

Send via e-mail

ZipGenius will create a new e-mail message with selected archive(s) as attachments. 

Extract here, in [path]

Just like EXTRACT HERE, but files will be placed in the specified folder.

Extract to [path]

Extract files to specified path.

Setup

Extracts all files to a temporary folder and run the "Setup.exe" file.

When you right click on other types of files (or folders), you will get the following items:

Add to archive...

Add selected files to an archive.

Create [archive name].zip

Creates a new zip archive with selected files and folders.

Create and e-mail archive...

It works ust as previous item, plus it sends the new archive through e-mail.

ZipGenius also can tell detailed info about a zip file when you move the mouse pointer over that

file, and you can add files to a zip file through Drag and Drop: drag files and/or folders over a zip

and they will be added to that zip file.

LibreOffice / OpenOffice Documents

If you enable the "Support to OpenOffice.org documents" in the Options panel, the context menu

associated to those files will have two new items:

Open with ZipGenius

Those documents will be treated by ZipGenius as standard zip files, allowing to modify the content

of the XML files into them and to extract pictures contained into those documents.

WARNING: changing the content of the XML files is not suggested to beginners, because

the document could be corrupted and it may become unreadable by OpenOffice.org.

 

Optimize document
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This feature shrinks a OpenOffice.org document using the maximum compression level.

OpenOffice.org documents are ZIP files with a different file extension, but the XML into them are

added using a medium compression level, so ZipGenius extracts those files and packs them again.

A small "ZG" comment is added: OpenOffice.org / LibreOffice won't take care about that. That

comment is used by ZipGenius to know if a OO.org document has been already optimized (when

you update the document in OpenOffice.org, the comment is automatically removed).

Created with the Personal Edition of HelpNDoc: Create iPhone web-based documentation

ZipGenius can show how files are organized into folders in an archive. This feature now is more

clever and you can filter the file list if you double click on a folder: ZipGenius will show only files

related to the selected folder. Click "Reload list" if you want to reload the full file list. Click "Upper

level" if you want to go to the upper level of folders. The "(-)" symbol is a placeholder that allows to

filter the file list in order to see only files stored without path information.

The "Upper level" button lets you see the higher level of folders stored in your archive, just as you

would do while browsing folders through Windows Explorer.

This feature is accessible from the "Panels" button of the SideBar.

https://www.helpndoc.com/feature-tour/iphone-website-generation
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Right-click on a folder to see a menu with all the available features. Some of these features are

available depending by archive format:

(click on a menu item to read its explanation)

List files in this folder

This is the default action and you can activate it by double-clicking an item in the folder view: the

file list will change to just show the files placed in the selected folder. (back)

Extract

This item will extract all the files placed in the selected folder. (back)
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Delete folder

This item will delete the selected folder. (back)

Compress... to new zip archive

The selected folder is extracted and compressed to a new zip archive. (back)

Publish folder to Web

The folder is extracted and published to a Web server through FTPGenius (back)

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Here you can modify main ZipGenius settings.

Associations

First of all, you can associate ZipGenius to all types of archive that it supports: choose one or more

file type and click on "Associate". This action allows to open associated file types with ZipGenius,

with just a double click on their icons.

ZipGenius user mode

Choose the ZG user mode that fits your level of experience in using PCs: if you feel as an expert

PC user, choose "Layout for advanced users" (the "EXPERT" indicator will appear in the status

bar); if you need a good help to compress files without hassles, choose "Layout for

everybody" (the "NORMAL" indicator will appear in the status bar).

When in EXPERT mode, all ZipGenius features depends by your actions and the program won't

help you in many cases; in NORMAL mode, instead, almost all actions are wizard-driven and you

have just to follow on-screen instructions.

In any case, you can still use the First Step Assistant: in ZipGenius it is placed in a bar above the

main toolbar; just choose an action in list and click "GO", then follow on-screen instructions.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

In this page you can write your personal info so they will be used as your zip archive signature (if

you will sign a zip archive).

Write your name, last name, e-mail address and (if you have one) your homepage address;

other info may be added in a later time.

Also, you can choose a picture of you (or another picture) to be shown in zip file signature: this

picture must be a .BMP file, sized 121x121 (or picture may appear malformed). If you won't

specify any image, ZipGenius will use the default one. 

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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Created with the Personal Edition of HelpNDoc: Free help authoring tool

There are three subsections here:

ZG STYLE

This section allows changing ZipGenius colors and font used:

Colors and font

ZipGenius aspect can be customized by using themes, a combination of skins, colors and fonts.

You can modify or create any theme and you can save these settings in order to use them each

time you run ZipGenius.

The SUITE edition offers some default themes, but if you have STANDARD edition, you may

download other themes from http://skin.zipgenius.it .

If you have styles installed, you need only to choose a style from list and to click "OK",

However you can create a custom style: you can modify background color, text color and font used

for the file list, plus you can change SideBar's look in "Sidebar" section, by using SKINS: you can

build your own sidebar skins, just ask to contact@zipgenius.com. Clicking on "Add theme" will

store color scheme and sidebar skin you have selected.

If you want to change an existing style, you have to select it from list, modify it and save it again

without changing its name: ZipGenius will ask if you want to update that.

Exporting a theme.

Click "Export style" and ZipGenius will export your current ZG Theme in a file, so that you can

share it with friends.

ZG Themes - send your theme to The ZipGenius Team.

Other themes will be available in the future and it may include ZG Themes sent by users (you have

just to export a style and send it to contact@zipgenius.com).

ZG Themes - how to install.

ZG Themes are really easy to install: just double click the .ZTM file and it will be copied to ZG skins

subfolder.

Toolbar

Here you can change settings related to the main toolbar of ZipGenius:

· Show button labels: shows buttons labels on the toolbar.

· Use selected font for buttons..: the font you selected will be used throughout the entire ZG

https://www.helpndoc.com/help-authoring-tool
mailto:contact@zipgenius.com?subject=Request about ZipGenius Theming
mailto:contact@zipgenius.com?subject=ZG Themes submission
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window.

· Use large characters: if you enabled previous item, characters' size will be increased.

· Icons size: you can choose between large and small icons.

· Other layout elements: you can hide/show many ZG interface elements.

The toolbar is skinnable. Skin files for ZipGenius 6 have the .ZT6 extension and they are part of

ZipGenius Themes. Don't try to install .ZTK toolbar skins, as they are skins for ZipGenius;

also, don't try to install .ZT6 skin files in ZipGenius.

Miscellaneous

· Single-click: select this option if you want to use a single click where a double click is

required.

· Show grid: enables the grid in ZipGenius files list.

· Full row selection: when you will select a file in ZipGenius list, its entire row will be selected.  

The other four options can hide/show some parts of ZipGenius user interface (Status bar, Info

bar, First Step bar, Sidebar). If you check all those options, you will get the most complete

interface; if all options are disabled, you will see a minimal interface with just the toolbar and

the files list (in NORMAL mode, "First Step" bar is always on an can't be removed).

FILE MARKER

If you have archives with many files inside, you may enable "file marker" feature to see certain files

in a crowded list. Enable this feature by checking the "Enable File Marker" box and ZipGenius will

mark all files related to the patterns you will add to the file marker list. You can specify to mark a

certain file by specifying its filename (ex.: "MyPicture.jpg") or you can force ZipGenius to mark files

of a given type (ex.: ".DOC"). NOTE: if you specify a filename for a file that may be marked due its

type, the filename pattern will have priority over the generic pattern. Example: if you set

"Report.doc" and ".doc" as patterns, ZipGenius will mark all ".DOC" files, but "Report.doc" will be

marked with the different attributes you gave.

Moreover, when this feature is enabled, ZipGenius will use it to mark the following default patterns

(not listed):  

· Readme.txt

· Setup.exe, Install.exe, Install.com

· Suspicious double file extensions: ".VBS.*" and ".JS.*" 
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LANGUAGE

ZipGenius now supports multiple languages, but English and Italian are shipped within the setup

package. In this section you can choose which one to use. All shell extensions will be affected, but

not SFX creation modules, which are available only in english or in italian. 

You can check for additional language packs by clicking on "Connect": you will see a list of all

available language packs on ZipGenius website. You just have to click on desired language pack

and it will be downloaded, then you have to install it (it is a self-extracting file).

Select a language and click "Apply".

The available language list will show only compatible language packs, so in ZG 6 you can't use

language packs v.102 but you will have to refer to the required language version. If you use an

additional language and ZipGenius is updated with a newer build that requires updated language,

the program may switch back to english if your language is not usable with ZipGenius newer build.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

This page is used to set some paths that can be useful to ZipGenius.

It is shared in two subsections:

Main

In "Initial Folder", you may choose a path as initial folder for ZipGenius open file dialog. Usually,

this path is th one where you find all the archives you use. You can choose from some default

paths or you can type a custom one.

In "External compression program", you can specify the path of external programs needed by

ZipGenius to handle archive files in oher formats than ZIP. For further information, see how to

install external programs

Smart Extract  

It is a ZipGenius new features. Here you can set the paths where ZipGenius will automatically

extract files upon file type (music, video and so on). Each file type will be extracted into a specific

path by clicking on "Edit">"Smart Extract".

NOTE: If you are running ZipGenius under an operating system different than Windows Xp, those

paths will be automatically created upon "Smart Extract" first usage. Under Windows XP or later,

ZipGenius will use system paths, but you can still specify custom paths (system paths won't be

https://www.helpndoc.com
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affected). 

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

In a different section of this help file, you will find a list of support archive types; here, instead, we

will see how to install external compression programs that you need for ARJ, ARC, ZOO and LZH

file. Without these programs ZipGenius is just able to show their contents; using them you will be

able to modify those archives.

Click on  "Options", then go to  "Paths" section and choose the format whose external program

you are going to install (.ARJ, as example); if you know the full path to that program , you can type

it, else you can click "Browse" to search it. Finally, click on "Save" to store that path..

WARNING! If you will click "OK" without clicking on "Save" before, paths won't be stored!

"Where can I find...".

This button will point your web browser to a ZipGenius website page, where you will find how to

obtain one of required external programs. Some programs can be downloaded directly from

ZipGenius website.

Show external programs running

By default, this option should be always enabled because it forces Windows to show these

programs while running; however, if you don't want to see other windows than ZipGenius one, you

can uncheck this box.

 See also:

· Supported archive types

Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Expert user may customize ZipGenius in an extreme way by accessing to the "Advanced

Settings" section in the Options dialog.

Here you will find seven sub-sections:

Misc. settings:

Preview file with associated program

When this option is enabled, ZipGenius try to open a file through the associated

program to that.

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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Export file list to format

You can tell to ZipGenius which format should be used by default to export the files list.

In this case, if you will click "Export", the program will automatically export files to

chosen format.

Show time spent

Enable this option to read how much time ZipGenius spent to complete an action. Don't

be trustful to timings reported because they are influenced by hardware and software

configuration.

Enable "Scan and Zip" feature

Enable this option if you want to import pictures from TWAIN devices, such as

scanners and digital cameras.

Show read progress bar...

Here you can set at which number of files ZipGenius should show a progress bar, used

to tell if it is reading the open archive. Default is "300", minimum is "50", maximum is

"30000"

Enable Zip Auto "Check Integrity"

ZIP files are often damaged while being downloaded and in that case you need to

TEST the archive, if you want to know if files can b extracted. If you want to do

automatically that, you cam enabled this option; optionally, you can force ZipGenius to

repair that. 

Details selection

Here you can choose which columns should appear when you will use ZipGenius in "Details" view

mode. If you check "Auto settings" option, ZipGenius will choose columns to show upon user

layout selected. If you want to see only common columns, just click on "Default columns".

Shell integration

Here you can set parameters for action started from Windows shell (the "context menu").

You can choose default compression level between "Maximum" and "Storage (no compression)".

You can enable ZipGenius shell extension by checking the box labeled "Enable context menu",

then you will see ZipGenius items in the context menu that will popup when you will click on zip

files or on other files. ZipGenius items can appear all listed in that menu or you can group them in

a submenu: check the "Use cascaded menu" box.

You can customize ZipGenius shell extension by choosing which items should

appear. NOTE: some item may appear or not depending by certain conditions (type of file, number
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of files selected, etc.).

ZipGenius supports also documents made with LibreOffice/OpenOffice. Even if this is an office

suite, it produces common zip files and give them a custom file extension; inside these files are

XML files that are needed to compose the document on screen. If you check "Let ZipGenius

support OpenOffice.org documents" option, ZipGenius will add two items in their context menu:

"Open with ZipGenius" and "Optimize". The last one allows to reduce OpenOffice.org documents

size).

Optionally, you can hide or show icons in ZipGenius items.

Check the "Drag over a folder to extract files" option to be allowed to extract files by dragging a

zip files over a folder with right mouse button.

Created with the Personal Edition of HelpNDoc: Produce electronic books easily

This section of the options panel lets you set several protection criteria for your data and

information.

Safety and privacy

This subsection allows to set the behaviour of the most recently used files list (MRU List). It can

be: Always enabled, Session Enabled or Fully Disabled. Moreover you can force ZipGenius to

encrypt the file that keeps tracks of the archives history in ZipGenius.

Recently Used Files

You can enable/disable or clean at each shutdown the list of recently used files. 

Encrypt Archives History

This setting lets you encrypt the file holding the history of archives opened with ZipGenius.

WARNING: each time you change this setting the history file get deleted.

Clean History File

This button clean the archives history file. 

Antivirus

Here you can set the command line to drive your antivirus software to scan an archive opened in

ZipGenius. AV scan can also be set to start automatically when an archive gets loaded by

ZipGenius.

Encryption (CryptoZip 2.x)

Store key without confirmation.

https://www.helpndoc.com/create-epub-ebooks
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When this option is enabled, ZipGenius will save your passphrase/passkey to ZG

Password Manager without asking to user.

Read also "How to create an archive"

Force processing on hard disk

This option force CZIP process to be executed on the hard disk and not in RAM. This

setting is effective only when you encrypt a zip archive through the CZIP algorhythm.

Default encryption method

Here you can choose the default encryption algorhythm between: CryptoZip, Rijndael

(AES), Blowfish and Twofish.

CZIP 2 default archive type

Here you can set the default CZIP 2 archive type between Standard, Self

Locking and Self Erasing.

Created with the Personal Edition of HelpNDoc: Easily create HTML Help documents

Click on "NEW..." to create a new archive: if you are using ZipGenius in "NORMAL" mode, this

action will be full driven by wizard, else ZipGenius will wait for your action (adding files, folders or

pictures from TWAIN devices). When creating certain types of archive, the program will ask you if

you want to add files or folders even in "EXPERT" mode.

See also:

· Adding files or folders
· Importing pictures

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

An archive will exist only if it contains one or more files, so you have to add them to the archive.

Adding files and folders is easy: you may have pressed the "New" button to create a new archive

or you may have opened an existing archive in ZipGenius and the "Add" button is enabled

(=archive type supports compression), but in both cases you will see the compression dialog show

up:

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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You will see a tabbed dialog where each page hosts a number of options that is different from one

archive format to another

FILES

Here you can select one or more files and/or folders in the explorer view you will see: you can

select multiple files/folders that are close each other by clicking on the first item to select, then

holding SHIFT and clicking on the last one. If you want to select multiple items that are not close

each other, hold down the CTRL key and click on any item you want to select. In few words, it is

the same way to select files/folders required by Windows Explorer.

MAIN SETTINGS

· Compression level: there are 6 compression levels available. The first one just stores files

without compression and it's the fastest way to zip files; second and third levels offer

proportionally better compression but they are slower than the previous one; "maximum" level

offers the best compression ratio and it's the slowest one. These levels compress almost every

kind of file that can be compressed, but files like GIF, JPG, TAR, GZ, ZIP, ARJ, ZOO are only
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stored because they are already compressed; if you want to try to compress them further, you

must choose the "brutal" compression level.

The 6th level is "Brutal+UPX" and is a ZipGenius 6 new feature available for just ZIP file

format: it allows to compress executable files like EXE, OCX and DLL throught

the UPX executable compressor. If you want to zip executable files, you may choose this level

and try to compress them further and obtaining better compression ratios than using the

"Maximum" or "Brutal" levels.

In order to activate this compression level you need to download upx.exe from UPX web

site and put it in ZipGenius program folder (usually "C:\Program Files\ZipGenius 6\"). When you

selected "Brutal+UPX" from copression options dialog, then you will see a new dialog that acts

as an UPX interface; that dialog will show a list of all the files that UPX can compress between

those you selected from ZIP compression. Now you have to set UPX compression level and to

click "Start". The UPX compressor will try to compress the listed files and it will return a result

beside the filename in that list ("Compressed", "Can't compress", "Already compressed").

When the UPX compressor will have finished its job, you will have to click "Continue" and to

wait for the common ZIP compression process to finish.

· Move files: selected files will be deleted from their original position after compression.

· Path: this box lets you choose whether to store the full or relative path info, or to store files

without path info. When you will extract these files again, you will get back the original folder

structure in the destination folder.

· Include subfolders: use this option when you want to compress a folder and all its subfolders.

· Password: check this option and write a password to protect files being added. Please note: a

standard zip password protects files only from extraction but everyone is still able to read the

entire file list of an archive. If you need better protection, you may want to encrypt a zip

archive in CZIP format.

· Add hidden and system files: this option allows to compress files which have "Hidden" and/or

"System" attributes set.

· Add files with "Archive" attribute: this option allows to compress files which have only the

"Archive" attribute set: system and hidden files are excluded.

· Reset "Archive" attribute: this option removes the "Archive" attribute from compressed files.

· File types: when adding a folder, this box lets you choose which file types should be included

in the zip file. By default, a folder is added with the "*.*" pattern, which means "all files", but you

can specify only certain file types. Example: if you want to add only .JPG and .BMP files,

write *.jpg;*.bmp . When you need to specify multiple file extensions, separe them with a ";" so

the program will be able to compile a list of file types to consider.

https://upx.github.io/
https://upx.github.io/
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· How to compress lets you set how the program should add files to the archive:

o Add files: files are just added to the archive; if a file with same filename already is in

the archive, that will be replaced.

o Freshen files: this option won't add any new file to the archive, but it will only update

already existing files if files being added are their newer version.

o Update files: just as Freshen files, but this option also adds new files to the archive.

ADVANCED SETTINGS

This page allows you to specify which files or group of files must

be included and/or excluded from compression process. You may specify file/folder names with

wildcards like * and ?. You can specify multiple entries using ; between them. If you don't specify

anything in these fields, the program will just add all selected items and no one will be excluded.

MULTIVOLUME ARCHIVE

Some archive types allow user to create multivolume archives (ZIP and CAB, in particular), so

he/she will get an archive that can be distributed on a set of removable media (floppy disk, CD-

ROM and similar media).

If current archive type supports multivolume archives creation, you will see the page labeled

"MULTIVOLUME", where you can set the related options. These differ from one archive type to

another and they usually allow to set volume size and volume files destination.

Is it possible to create new archives without using the main application?

Yes, it is by using the context menu: select one or more files and/or folders, and click on one of

them with the right mouse button. You will see the context menu with many commands, included

those installed by ZipGenius (you can recognize them by the ZG logo).

The archive creation features are the following:

1. Add to (filename).zip

2. Add to any ZIP archive...

3. Create  new archive with options

4. Create and e-mail archive

5. Compress to 7-zip

The options #1 and #3 are almost the same, but the second one allows to se compression options

as if you were using the main application.

The option #5 is a new feature and it allows to create 7-zip archives, an open source compression

algorhythm that is changing the way to compress files, that offers performances that can be
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compared to those of RAR and ACE (warning: it may require a lot of RAM at higher compression

levels!)

Does ZipGenius support drag and drop compression?

Yes, it does. When an archive is already open in ZipGenius, you can add files and/or folders by

simply dragging them onto ZipGenius files list, then you willl see the compression options dialog

and you will be allowed to begin compression.

 

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

When you want to add files and folders to an archive, ZipGenius offers the chance to set a

compression level. This usually happens with .ZIP and .7Z archive and these are the available

levels:

· No Compression

· Minimum

· Medium

· Maximum

· Brutal

Quite self-explanatory, "No Compression" doesn't compress files but stores them as they are into

the archive; on the other hand, "Brutal" tries to compress the files as much as possible.

WARNING! Not every kind of file can be compressed due to its own nature. Files like

.PNG, .JPG, .MP3, .MP4 and others, are already compressed since they were generated: trying to

further compress them will result in just 1-2% of size decrease. In the worst case, you could get

the opposite effect and file size might increase. In order to avoid this side effect, ZipGenius can

automatically recognize precompressed files that you set to compress (again) through the "Brutal"

compression level and it applies the "No Compression" level to just these files.

An additional compression level is called "Brutal + UPX" and it's activated by downloading the UPX

compression tool, which is an executable files compressor, and by putting it into ZipGenius

program folder. Read more about it.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

UPX is a truly powerful compressor for executable files like EXE, DLL, OCX: the ZipGenius main

executable (zipgenius.exe) is itself compressed with UPX before deploying it.

Now ZipGenius allows to create ZIP archives with smaller size, because it can precompress the

mentioned file types through UPX. UPX is automatically installed by ZipGenius Suite Edition

https://www.helpndoc.com
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
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setup; owners of ZG Standard Edition can download UPX from its website.

UPX precompression is available only when you are going to create a new ZIP-like archives

(see supported archives list) or when you want to add files/folders to an existing one, and only

if upx.exe is placed in ZipGenius program folder. When these two conditions are satisfied, the

compression options dialog will offer a newer compression level named Brutal + UPX. If selected,

ZipGenius will apply brutal compression level and it will precompress executable files through the

UPX interface.

The UPX precompression dialog will appear after you will have started the compression procedure:

it will gather info about files that are going to be added to the ZIP archive and it will create a list of

files that can be precompressed through UPX. The dialog will allow you to set UPX compression

level: 7 is the default level, 9 is the maximum and 1 is the minimum level. 

WARNING! Higher compression level will require more resources to your system (RAM

and free disk space, mainly), and the whole operation may result very long.

When you will click Proceed, UPX will try to compress the files listed in the UPX dialog and each

filename in list will show an icon that will tell you the result of the procedure: "Compressed",

"Already compressed" or "Unable to compress".

After precompression, click "Continue" to continue with the normal compression procedure.

Created with the Personal Edition of HelpNDoc: Generate EPub eBooks with ease

Click on Extract to begin files extraction.  

https://upx.github.io/
https://www.helpndoc.com/create-epub-ebooks
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There are several ways to extract files from an archive: the most intuitive is to click the "Extract"

button and let the extraction dialog appear. The extraction dialog shows all the options you may

want to set before extracting files, like destination folder or the behaviour of the program when it is

going to overwrite files in the destination folder. If no file is selected in ZipGenius files list, "All

Files" option will be selected automatically; if one or more files are selected, ZipGenius

automatically will check the "Only selected files" option. Beside these options, you can see the

options "Only files of type", which allows to extract only certain file types, and "By folder", which

allows to extract files related to a certain folder (files have to be stored with path info).

There are also other ways to extract files: in the extraction dialog you will find a useful sidebar with

links to common system folders (Desktop, My Documents and so on): click on a link to set that as

the destination path.

Also the "Extract" button and the popup menu have been enhanced with a new submenu called

"Extract to...", where you will find the same list of common links: just select some file, right click

and choose where to extract them. If you right click with no file selected, ZG will extract all files in

archive.

OPTIONS

Use subfolders info

This option allows to rebuild of the original folder structure if files have been stored together

with folder info.

Open destination folder

When extraction ends, it will open the destination folder.

Run Setup

If a setup file is in the archive ("SETUP" should appear in the status bar), ZipGenius will run

that file at the end of extraction procedure.

Quit ZipGenius

When extraction ends, ZipGenius will shutdown itself.

You have also to tell ZipGenius how to behave when it is going to extract files already existing

in the destination folder:

o Don't overwrite - files already existing will be skipped.
o Always Overwrite - files already existing will be replaced.
o Freshen files - extracts and updates only file already existing in the destination folder;

existing files will be replaced only if older than the compressed version.
o Update files - extracts new files and updates existing files if compressed versions are

newer.
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o Ask Before Overwrite - ZipGenius will ask you what to do.

Destination

In this box you can set in which folder ZipGenius will extract files. You can use the tree view to

browse folders or you can type directly the path in the related field. Check "Create a folder

from archive name" if you want to create a subfolder in the destination path whose name

derives from archive file name. Example: if archive name is "MyArc.zip" and destination path is

"C:\Temp", ZipGenius will create a subfolder and the destination path will be "C:\Test\MyArc".

Any path you will write in the destination field, it will be checked and non-existing subfolders

will be created automatically, so if you write "C:\Test\MyFolder" and "MyFolder" doesn't exists in

"C:\Test", ZipGenius will create that automatically.

Special destination folders

Starting from Windows XP you are allowed to write files to a CD-R without using external

applications. When you do that, Windows XP copy files to be burned to a special location that

Windows represents as your CD-R writer device. You can extract files to that location by

choosing "CD-R/RW" in the destination folders list. This feature is also available in ZipGenius

popup menu and in the sidebar, for quick extraction to this location but with a small difference:

when using this feature from the popup menu, ZipGenius will use path info by default; if you

don't want to rebuild original folder structure in the CD-R folder of Windows XP, you have to go

to "Options">"Advanced Settings">"Misc. settings" and to check "Extract to CD-R without

folders". This procedure is not necessary when using the common extraction dialog, because

the CD-R/RW writer is treated as a common folder. If you have special UDF applications (such

as Ahead's InCD®) you can directly write files to a CD-RW because InCD overrides the system

default behaviour and it's able to write files in real time to CD-RWs.

Extracting an entire folder.

Sometimes you may need to extract an entire folder from an archive and you can choose the

specific option from the extraction dialog, just as you can read above.

Anyway there is a faster and easier way to achieve the same result:

1. Open an archive: ZipGenius should show the directory structure in the "Folder" view on the

left of its window:

2. Browse folders to find the one you want to extract

3. Select that folder and drag that to any other Windows folder (or to the desktop) by holding the

left mouse button and moving the mouse

4. Release the mouse button to begin extraction.
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Created with the Personal Edition of HelpNDoc: Free Kindle producer

WARNING! BE CAREFUL WHEN USING THIS FEATURE!

The "Delete" command is only in the popup menu in order to avoid unwanted file deletions.

"Delete" acts as follows:

· if one or more files have been selected, the program will ask if you really want to delete

them;

· if no file has been selected, the program will ask if you want to delete all files from the

archive. If you will answer "YES" all files will be removed and archive will be ready to accept

new files; if you will close an archive with no files inside, it will become unreadable (no file ->

no archive).

The "First Step Assistant" also offer the chance to destroy the current archive.

Created with the Personal Edition of HelpNDoc: Full-featured EPub generator

ZipGenius allows to rename an archive without quitting from the program.

Click on "Rename Archive" in the "File" menu or in the sidebar to do that. Also you might click on

"Archive Properties" to see a dialog reporting info about current archive: here you can type the

new name you want to assign to that archive and click on "Rename archive" button to complete this

action.

WARNING: nested zip files can't be renamed if it is open in ZipGenius, but you can do that when

you see that archive in the file list related to the main archive. You have to select that zip as you

would do with other files, then click on "Rename file" in ZipGenius popup menu.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Since previous editions, ZipGenius allows to put a "signature" in zip archives; this is just an

additional file, containing your personal info (name, e-mail and Web address) plus a small picture

(which can be a picture of you or your company logo) and a brief description of what's inside that

archive. REMEMBER: the picture file you can use in your signature must be sized 121x121 and it

must be in .BMP format. This signature can be read by ZipGenius 1.3.x or newer and all other zip

program supporting ZGSign technique.

To put a signature in a zip file, just click on "Sign archive" in the sidebar, or click on

"Signature">"New signature" in the "Tools" menu.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
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Created with the Personal Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

Zip archives are often used to distribute applications over the Internet, so those zip files contain

files labeled "setup.exe", "setup.com", "install.exe" or "install.com", which usually starts

program's setup; ZipGenius can detect those files and it can start setup.

When one of the above file has been detected, ZipGenius shows the text "SETUP" in the status

bar and the related menu items will be enabled: just click on one of these to being action.

ZipGenius will extract all files in a temporary folder and it will launch the setup file, then you have to

follow the setup program to continue.

You will see a message from ZipGenius which will advise you to click "OK" when setup process is

finished. REMEMBER: if you click "OK" when setup is still running, ZipGenius will try to delete all

the temporary files extracted before and you may get errors.

This feature is not available for all types of archive.

Created with the Personal Edition of HelpNDoc: Free HTML Help documentation generator

ZipGenius allows to rename files compressed in zip archives.

Just select one file and right-click on it, then choose "Rename" from popup menu, or select a file

in the files list and press "F2" on your keyboard. You can rename that file as you usually do within

Windows Explorer.

Created with the Personal Edition of HelpNDoc: Easily create EBooks

ZipGenius allows to preview a compressed file: it will extract the selected file in a temporary folder

and it will show that in different ways, then the file will be deleted.

Not all file types can be previewed: this depends by file type and selected user layout for

ZipGenius.

NOTE: you can preview just one file at a time, so you can't use "Preview" feature if you

select more than one file in ZipGenius window (excepted when you use "Preview

Pictures").

ZipGenius will try to open the selected file with its associated program; if no program is associated

to that file type, ZipGenius will try to show selected file in its internal viewer.

SECURITY FEATURE

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com
https://www.helpndoc.com/feature-tour
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During the last years, virus writers have found a good workaround to

spread viruses through e-mail and avoiding antivirus checkings: they

send them as password-protected zip files because EVERY antivirus

software can't open them. ZipGenius, instead, can open password-

protected files because it is designed to do this, by asking the

password to the user, so this could be a potentially dangerous action if

you don't know the sender of that zip file.

ZipGenius 6 introduces a security check before running any file that

could be dangerous to your system and your data: if you set the path

to an antivirus software in the options panel of ZipGenius, when you

will double-click on a file, you will be prompted to perform an antivirus

scan before executing the selected file. You can accept to perform that

scan, but you can refuse that if you are sure of what you are doing, or

you can cancel the whole action.

If you right-click on a file in the files list, you will find the "Preview" menu item, which has a

submenu with three items:

USE INTERNAL VIEWER

This allows to read documents that can be read as text document; if text contains an URL or an e-

mail address (written as mailto:name@provider.xxx), you can click on that text to activate

hyperlink.

USE ASSOCIATED PROGRAM

This menu item works just as the double click on a file listed in ZipGenius.

HEX  VIEWER

When you don't know what kind a file is, you can open it in the HEX viewer to see its hexadecimal

and ASCII representation.

PICTURE PREVIEW

ZipGenius can show all pictures in an archive just as Windows XP does in "Preview" mode: just

select "Picture Preview" in the View menu.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Before reading this page, a consideration about Self-Extracting executables.
In 2020 you should avoid creating self-extracting executables for some reasons:
1. they might be used to spread malware;
2. because of reason n. 1, ISPs may block .exe files attached to e-mail messages;

https://www.helpauthoringsoftware.com
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3. executable files in .EXE format work only in Windows: the vast spreading of other operating
systems that can't run .exe files directly is making these files useless.

Sometimes you need to send a zip file to someone who hasn't a zip program installed. How can

you show him/her the contents of your Zip file? Simply: convert it to EXE. This feature transforms

common zip files into Windows Executable files, which don't need any program to be opened

because they can extract files by themselves. 

With ZipGenius you can create two different types of Self-Extracting Files (SFX):

· Common SFX: this kind of SFX provides only basic extraction feature;

· Self-Installing: this one can extract files and run SETUP.exe. This one can be created only if

a setup program has been detected into the archive being converted.

 ZipGenius can use SFX Options files: these files can store the options you choose while creating

a new SFX archive. You can store settings at the end of the SFX creation procedure (see below) or

you can click Start>Run and type zg -SFX -TEMPLATE to force ZipGenius to create a option file

template on your desktop. 

If you have previously stored an SFX Options file (it has .SOF file extension), you can reload those

setting just at the beginning of this procedure. 

ARCHIVE TITLE

Tell which is the name of the archive: it will be shown in the caption of SFX window.

In this same page you will be warned if the zip file being processed contains a setup program

(setup.exe, install.exe or install.com detected): you will be allowed to choose between creating a

self-installing archive and creating a common SFX file. In the first case you could also choose to

force the SFX to extract files to a unique temp folder (you won't be prompted do tell a default

extraction path).

DEFAULT EXTRACTION FOLDER

Tells to the SFX file where it must extract files.

You can also force the SFX to read a value from a given Windows Registry key; this feature is

really useful for Web page designers and software developers who need to send files that they

must be extracted in certain folders, whose path may differ from user to user.

ZipGenius offers some default Registry keys:

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Desktop

User's Desktop path

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Favorites

User's Favorites path
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· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\My Music

My Music folder

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\My Pictures

My Pictures folder

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\My Video

My Video folder

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Personal

My Documents folder

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Start Menu

Start Menu folder

· HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Startup

Startup folder

· HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Common

Desktop

Common Desktop folder under NT/ Windows 2000 / Windows XP or later

· HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Common

Favorites

Common Favorites folder

· HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Common

Programs

Common Programs folder

· HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders\Personal

Common My Documents folder

Warning: some of these keys may have no effect if your SFX runs under Windows 9x/ME: in fact,

these operating systems don't allow advanced multi-user profiles as Windows NT/2000/XP do, so

it's suggested to use registry keys for users (those beginnning with HKCU).

You can specify also custom registry keys. 
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Example: you want that your SFX reads a folder path stored in the "AppPath" string value shown

above: to do that you must copy the highlighted part of key name, to add a "\" and finally to add the

value name (AppPath). You will obtain: HKEY_CURRENT_USER\SOFTWARE\M.DEV

SOFTWARE\ZGTOOLS\APPPATH. The name of the value to read must be always put at the

end of key name or the SFX will read the DEFAULT value.

You can write the initial part  othe key name both in long or short format: 

· HKEY_CURRENT_USER or HKCU

· HKEY_USERS or HKU

· HKEY_LOCAL_MACHINE or HKLM

These are the only registry keys that contain folder paths. Environment variables are

supported (ex.: "%windir%). 

DESTINATION SUBFOLDER

Here you can specify in which subfolder of the destination path the SFX must extract files (even if

path must be read from the Registry). You can specify subfolders on multiple sublevels (ex.:

"Lib\Vcl\Test\Test 2"). Non existing subfolders will be created.

ICON

You can customize your SFX by choosing an icon to better represent its contents. You must use

only .ICO files.

STARTUP MESSAGE

You can make appear a message when someone opens your SFX file. You can choose among

thrre kinds of message: standard, information, request. If you don't want to show any message,

leave blank the text field and click "Next".

AUTORUN OF A FILE

If you want, you can choose which file should be launched when extraction is finished.
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OTHER OPTIONS

This is the last step: here you can modify other settings of your SFX.

· Files list - this option allows you to choose to make the file list visibile, initially invisible or

always invisible.

· Allow user to deactivate autorun... - this options allows user to deactivate the autorun of

the file you have selected.

· If a file already exists... - choose how the SFX should behave if a file being extracted is

already placed in the destination folder.

· Hide overwrite mode selection - check this option to avoid further changes made by final

user to the previous option.

· Allow user to modify the list of files to be extracted - you can allow the final user to

decide to extract single files or the whole content of the archive.

· Show confirmation message  - when extraction will be finished, the final user will see a

confirmation message.

· Expand environment variables - this option replace the exact path associated to

environment variables (ex.: %windir% will be replaced by the exact path of Windows folder).

· Allow user to abort extraction - enables or disables the "Cancel" button in the SFX GUI.

· Save in an options file - ZipGenius will ask where do you want to save the .SOF options file.

If you want, you can save these settings in an SFX Option File so that you can reuse them in other

sessions.

Click "Next " to complete the creation of SFX file.

You can also create SFX files from ARJ and LZH archives. 

SFX archives can be also made through the command line, which relies on an options file: this is

a file that ZipGenius can read to set the SFX options. This means that you can store the option file

where you want and that you can reuse this file as many time as you need. This is extremely

useful if you need to create many SFX files through a .BAT or a .CMD file, using different options

for each one. You can find the right syntax for th SFX switch in the Command Line section of this

help.

As you can see, each SFX will have the appropriate options and you don't need to remember what

options to use for a given zip file. Creating a new option file is quite simple because you have only

to type zg -SFX -TEMPLATE in the command line: a new option file template will appear on your

Desktop so that you can modify and save it where you want.
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Created with the Personal Edition of HelpNDoc: Generate Kindle eBooks with ease

You can protect files in a zip archive with a password, but this doesn't mean that you can

protect your files list from reading, because a zip password protects files only from

unauthorized extraction.

ZipGenius can protect an archive with standard industry zip password, but this feature is still

present only to ensure compatibility with other zip programs; if you need more protection, you may

consider using the CZIP 2.1 technique, which encrypts archives in several different ways.

When you want to extract password protected files, you can type a password just in the related

field in the extraction dialog, but sometimes files may be protected with different password: in this

case, ZipGenius will ask you a new password to continue file extraction. 

Tips for choosing a good password

Even if password technique becomes weaker day after day (encryption techniques are stronger

than a simple password), it is still a wide spread way to protect files, so choosing a good password

is just the first step. Just follow these tips:  

· Password should be at least 8 characters long; longer passwords require longer work to be

cracked with password cracker applications;

· use "illogical" passwords; don't use people's name, birth date or real things names, etc., but

use a casual sequence of characters (ex.: "xOOp24CcFFg");

· increase password strength by using ALPHANUMERIC characters and both letter cases (see

previous example);

· don't use always the same password for different archives;

· if you can, change password periodically;

· don't tell your password to anybody: be jealous with it;

· third parties' password managers are really comfortable to use, but it would be a good idea to

store password list in a safe place away from your PC. Nothing is safe, even the strongest

encryption algorithm around.

These tips apply also to passphrases used for CryptoZip encryption techniques.

NOTE: when you use a standard zip password, it is not stored in ZipGenius Password

Manager.

Created with the Personal Edition of HelpNDoc: Free EPub and documentation generator

Virus number grows day after day so everyone should have a good and up to date antivirus

program. With ZipGenius you can scan archives through the antivirus program you have. You can

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com
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decide to force ZipGenius to launch antivirus program before opening an archive or you can click 

Today everyone must have a good antivirus program to be safe on the Internet, so ZipGenius now

can force your antivirus to scan archives before opening them, or you can scan them when they

are already opened in ZipGenius through the related item in the popup menu of ZipGenius.

This feature must be enabled from the "Options" panel, in the "Antivirus" page.

First of all, you must type the full path to your antivirus program. Each program has its own path

and filename, so it's up to you to find the right path. You can click the "Browse" button attached to

the path field or you can type directly the path into that box. If you need help, you can click the

button labeled "Antivirus Web List" that will open your default web browser and point it to a

special page in www.zipgenius.it, which hold a list of already known path for some antivirus

program.

The "%s" symbol is a placeholder: ZipGenius will substitute it automatically with the filename of the

archive being scanned. Be careful when you place this symbol, because if it is in a wrong position

in the command line, the antivirus may fail to start.

When scan will be finished, ZipGenius will ask you if the AV program found any virus.

Created with the Personal Edition of HelpNDoc: Free Web Help generator

When you need to send a large archive via e-mail or stored ina floppy disk, you must take
care about the file size. Even if you connect to the Internet through high speed
connections, sending a large file may become a problem because many ISP put a size
limit to the attachments you can send via e-mail; moreover, floppy disk still are the most
used removable media in certain countries where CD burners still have high prices. In
this case you have to build a Multivolume archive, which is the original archive divided
in smaller parts.

Multivolume features are in the "Multivolume Archives" section of Actions menu and
are:

· Disk Span - this action lets you divide the archive in smaller parts
· Disk Unspan - this action lets you rebuild the original archive on your hard disk

ZipGenius way of creating multivolume archives is different from other program and it is
a bit more logic:

1. First of all, you have to create a ZIP archive as you usually do;
2. click on "Disk Span" to start splitting the archive.

This procedure lets you modify your archive until the second before you start to split it,
because ZipGenius doesn't write spanned archives directly when you create a new one:
you can create and correct your archive as you want (or need), then you can split it in
smaller parts.

You will see a dialog where you can choose the destination unit for the spanned archive.
As you can see, you can choose even an hard disk: in that case ZipGenius will ask you
where to create a subfolder labeled "ZipGenius Span Output", which will contain the
resulting file parts. This option is useful when you don't want to send file parts directly to
a floppy disk set, or when you need to send file parts through the Internet. Choose the

http://www.zipgenius.it
https://www.helpndoc.com


ZipGenius 6 Help

40 / 80

floppy disk unit to span archive on a set of floppy disks.

If you choose an hard disk as destination, you must select a size for the file parts being
created. ZipGenius offers some default sizes to choose between, but you can set a
custom size in bytes.

On the contrary, if you choose to span archive on a set of floppy disks, ZipGenius will
start that action and will require the first disk you want to use; the program will check it
and if disk isn't empty, ZipGenius will ask if you want to erase it. WARNING: erasing
the floppy disk will make you lose any kind of data stored into that.

The resulting file parts will have different file extensions:

· .ZIP - this will be the only file you can read with zip programs
· .z01 ... .zXX - these will be the file parts and they can't be read by zip programs

Warning: ZipGenius has adopted this new spanning scheme, which is compatible with
WinZip®, but other zip program may fail to read archives spanned in this way.

The reverse action is labeled "Disk Unspan" and it is used to rebuild the original archive.
You will be prompted to select a folder where to recreate the archive and the program will
do the rest.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Please note: we don't suggest to use this feature anymore because we made a
truly new application that does this job better. It's called CZIP X.

One of the most important features of this versione of ZipGenius is CZIP (formerly known
as CryptoZip). This technique offers a better protection for zip archives than the standard
password protection method. Today there are many password recovery utilities on the
Web, which are really able to discover zip standard industry password; if you use one of
them, sooner or later that program will find the correct password and will open the zip
file.

On the contrary, ZipGenius can encrypt zip files using four algorhythms:

1. CZIP: this is ZipGenius custom algorhythm. It is slow (so it's suggested when
encrypting small archives) because it encrypts byte-per-byte, but it's quite secure.
You must enter three values between 0 and 65535 ("0-0-0" is not allowed), so you
have 1 on 281.474.976.710.656 available combinations. Probably it can be
cracked, but it would require too much time to try.
When the original zip file is larger than 10 MB, CZIP algorhythm is not suggested if
you want a fast encryption (see below).

2. BlowFish: you must enter a pssphrase. The longer passphrase you will use, the
stronger encryption you will get. Faster than CZIP.

3. TwoFish: you must enter a passphrase. It's faster than CZIP and BlowFish, it's more
secure than BlowFish.

4. Rijndael: you must enter a passphrase. It's faster then CZIP, slower than BlowFish
and TwoFish, but stronger than all the other algorhythms.

ZipGenius introduces CZIP 2.1 file format. This is still an encrypted zip archive but nw its
header stores some info and it will let know quickly if given key or passphrase matches or
not, without waiting to decrypt the archive and see if decryption failed or not. With CZIP
2.1 files you can store your name and your e-mail address, so that who receives your file
can contact you in an easy way. Moreover, CZIP 2.1 let you create three kinds of CZIP
files:

· Standard
· Self-locking: after three wrong keys/passphrases the CZIP archive locks itself.

https://www.helpndoc.com/help-authoring-tool
https://www.helpndoc.com/help-authoring-tool
https://www.czip.it
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· Self-erasing: after three wrong keys/passphrases the CZIP archive delete itself.

Finally, you don't have anymore to send any tools to someone before you send him a
CZIP file: now you can create Self-Decrypting Archives (SDA), which are in executable
format, just as if they were SFX files.

ZipGenius now has a Password Manager to keep track of all keys and passphrases used.
The Password Manager can be reached both from ZipGenius and from the Start Menu, and
it allows to export the list of keys and passphrases.

WARNING! Once you have encrypted a zip file with CryptoZip, you MUST use the
same key you used to encrypt the original zip file, otherwise the encrypted file
will remain unreadable. For this reason it is suggested to let ZipGenius store the
key/passphrase in the Password Manager.

You can encrypt a zip file by clicking on Actions>Encrypt in the main menu.

If CZIP file has been encrypted with CZIP algorhythm you will have to write the three
values used to encrypt it; if archive has been encrypted with one of the other
algorhythm, you must type the right passphrase.

Password Manager (optional in ZG Standard)
The new Password Manager replaces the key list dialog available in previous versions of
ZipGenius. It is a stand-alone application and it can be reached even from the Start
Menu. PM stores all the keys and passphrases you use to encrypt zip files, if you check
the related box in the encryption wizard.

If you leave this box unchecked, the key/passphrase won't be stored.

PM stores these info in an encrypted list in order to offer more protection to your data.
When you run PM for the first time, it will prompt you to set a password to allow access to
the key list. Once you log in, you will see the following window:

When you gain access to PM, you can:

1. Load a .ZGK file
2. Reload the default key file
3. Copy selected key/passphrase to clipboard
4. Export key list to a .ZGK file
5. Print the key list
6. (See point #3)
7. Delete selected item
8. Change login password
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9. Exit

You will see the list of all available keys and passphrase: you have only to choose one and
to report it in the CZIP password box you will see while opening an encrypted archive.
When you open an encrypted archive you are prompted to type a key/passphrase or you
can click on "Password Manager" to launch PM: if you do so, PM will perform a search in
its default key file and, if it finds a filename entry that matches the CZIP filename, it will
mark this entry with a red background. Now you can copy the key/passphrase to
clipboard (use the related button or right-click on marked entry) so you may paste it in
CZIP password box.

PM can be used to read other key files but only if those were created by your copy of PM:
when you export a list to a .ZGK file, PM puts the password used to access to PM in that
file; when file will be loaded, PM will check if login password is equal to the one stored in
the ZGK file. If passwords match, you will see the imported key file, else you will get an
error message. REMEMBER: it is highly suggested to leave login password equal to the
one used for the first access, because if you change it after you have exported any .ZGK
file, those files might be unreadable due to the new login password. This is a security
feature: the default key file (the one loaded when PM starts running) is automatically
updated with the new login password, so it will be always available to you. That's why it
is really important to choose a good login password when PM runs for the first time.

ZGK files can be created by clicking on the related button in the toolbar: the program will
ask you to type the login password again, only to do a quick security check, which has no
effects, however, on ZGK file creation.

Created with the Personal Edition of HelpNDoc: Produce online help for Qt applications

Some time ago plain picture scanners were the only devices used to import pictures to
the PC, but today digital cameras are a great reality and everybody is going to replace his
old film camera with a digital one. That's why ZipGenius' Scan and Zip feature has been
enhanced. In this version Scan and Zip is presented as a wizard, so you will be guided
through the whole process that will import one or more pictures to ZG.

Scan and Zip and ZGAlbum are optional components for ZG Standard setup file.

REQUIREMENTS
This function needs TWAIN drivers to be installed. If your imaging devices have custom
drivers, ZipGenius can't import pictures.

Click on the  "Scan & Zip" item in the sidebar or in the main menu.

Now follow these steps:

1) CHOOSE PICTURE FORMAT.

Choose which picture format ZipGenius should use: if you choose JPG you can also select
a quality level between 0 and 99, where 99 is the best quality. Remember this: a JPEG
file will have a very large size if you choose the best quality, but you will obtain
a small JPEG file if you will choose the worst quality (colors will be dramatically
reduced). In any case, you can choose .BMP format, which can be highly compressed.

2) CHOOSE A GROUP NAME and IMPORT IMAGES.

First of all you must choose a name for the picture(s) you are going to import. This is
important because ZipGenius will save pictures using this name plus a number in the
filename. Example, if "Summer" is the group name:

· Summer (0).jpg
· Summer (1).jpg

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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· ....
· Summer (X).jpg

When you have typed the group name, you can click on "Import pictures" to run TWAIN
interface. Make sure to have a TWAIN device connected!
Choose any image you want to send to ZG. When ZG finishes to save pictures in its
temporary folder, you will see the first image in the small preview; now you can browse
pictures using the arrows and the "home" buttons. When an image is displayed, you can
click on "Preview and edit" to see it in its default size through ZG's pictures viewer.
When you do this you can also rotate pictures so you can store them in the right position.
When a picture is shown, you can also delete it by clicking on "Delete selected".

From ZipGenius.1 you can even capture your desktop to create screenshots: click on
"Capture Desktop" and ZipGenius will minimize to leave your screen free and ready to
be captured. You can take how mant shots you want: just press F1 on your keyboard to
capture screen. Press F11 to go back to ZipGenius: you will see all your shots in the
preview frame.

3) FINAL STEP: COMPRESSION.
ZipGenius allows to compress pictures also in .CAB and .7z format: you have only to
choose which fits your needs:

Format PROs CONs

ZIP
Widely used. Choose this
format if you need to send
your pictures around.

Has a good compression
ratio only with BMP
pictures because they
aren't already compressed

CAB

Good storage format:
useful if you want to store
pictures without
compression.

Very low compression
ratio.
Not very used around.

7z

High compression ratio. It
uses many new
compression techniques
and it is suggested to
store pictures and
multimedia files.

Not known as ZIP format,
few programs can handle
it.

If you have ZG Album installed, you will see also an option labeled "EXE (Make
slideshow)". If you choose this option, ZipGenius will start the process to build a picture
slideshow (see: Making a slideshow). Pictures will be stored in a zip file which will be
converted to EXE and it will include a small applet capable of showing pictures.

Created with the Personal Edition of HelpNDoc: Full-featured Kindle eBooks generator

ZG Album is a new optional component for ZipGenius. It is shipped within SUITE Edition
but you can decide to avoid its setup. STANDARD Edition users must download it
from www.zipgenius.it. ZG Album allows to build pictures slideshow so you can send
your pictures to your parents, relatives and friends without hassles.

You have two ways to make a slideshow:

1. Click on "Make a slideshow" item in the main menu: ZipGenius will ask you to
choose a folder containing .BMP and .JPG files.

2. Click on "Scan and Zip" to import pictures from a TWAIN device and choose "EXE"
as archive format.

When ZipGenius will be ready to create the slideshow will ask you some customization:
choose a title for your slidshow and fill all the other fields, then go to the "Pictures" tab
and click: here you can write a short comment to each picture and choose which picture

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
http://www.zipgenius.it
Scan___Zip.htm
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you want to add to the slideshow. You will see a thumbnail of selected picture and its
default comment (usually, its filename). Write a comment, if you want, and click "Save
comment".

You can protect your slideshows with a password.

When you are ready, you have only to click on "Proceed" and ZipGenius will build your
new slideshow. It is a special SFX which will extract files to a volatile folder before
running the slideshow applet. That folder will be removed at next reboot.

Created with the Personal Edition of HelpNDoc: Easily create CHM Help documents

ZipGenius can be use through the command line, so you can write batch procedures to
automate the tasks you do many times and in the same way. Here is the list of available
commands, where everyone has its own syntax and options set.

· add
· backup
· oerestore
· extract
· delete
· destroy
· print
· export
· mail
· sfx
· optim
· encrypt

 

Created with the Personal Edition of HelpNDoc: Full-featured Help generator

Syntax:
-add archive {options} +file {-file}

Overview:
This command lets you compress files and folders in an archive; if the specified archive
already exists, files and folders will be added to that.
Not all archive formats allow files compression: you can create ZIP, ZIP-based, TAR, TAZ,
TGZ, TAR.GZ, TAR.BZ2, SQX, CAB archives. You can tell the program which format you
want to compress to by specifying the filename extension of the archive, so "test.zip" will
create a ZIP archive, while "test.cab" will create a .CAB one.

Options:

+ (file/folder)
 

Adds file/folder to archive: you must specify at least
one file/folder to compress.

You can use wildcards ( * or ? ) to add a group of
files that are of the same file type or that have
similar file extensions.
A command line with the "-add" command can have
multiple "+" parameters so you can add multilple
files and folders at once.

Example.:
+*.* (adds all files)

https://www.helpndoc.com/feature-tour
https://www.helpndoc.com/feature-tour
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+file1.txt (adds only file1.txt)
+"C:\My Documents\*.doc" (adds all .DOC files in
My Documents folder)

See other examples below.

- (file/folder)
 

Ignore files and/or folders.

When you use the "-add" command to perform a
massive compression operation that involves groups
of files and/or folders, you may want to exclude
some file or folder from being compressed by using
the "-" parameter.
You can use wildcards ( * or ? ) to specify which
file(s) and folder(s) should be ignored by ZipGenius
while compressing. A command line with the "-add"
command may have multiple "-" parameters in order
to exclude multiple files/folders, but you must use at
least one "+" parameter in the same command line.

Examples:
-*.* (all files)
-file1.txt (only the specified file)
-"C:\My Documents\*.doc" (all .DOC files in My
Documents folder)

See other examples below.

@ (file list)
 

This option lets you specify which files and/or folders
should be compressed through a list stored in a text
file.
The "@" parameter is used to indicate the full path
and name of the file that must be read by
ZipGenius; the text file that will hold the list uses
the "+" and "-" parameters as described above.

Ecamples:
@"c:\My Documents\mylist.txt"
where "mylist.txt" holds the following list:
+"C:\Test\*.*"
-"*.txt"
-"*.tmp"
-"*.jpg"

C [0 | 1 | 5 | 9 | B ]

 

Sets the compression level.
Default value is C0, which will automatically be
selected if "C" option is not specified in the
command line.

"C" must be associated to one of the following
values:

· 0 - no compression
· 1 - low compression, max speed
· 5 - medium compression and speed
· 9 - max compression, low speed
· B - "brutal" compression, lowest speed

Example:
zg -add test.zip C9 +*.doc
Max compression level will be applied.

A [ A | M | U ] Sets compression mode.
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  · AA - adds files to archive
· AM - moves files to archive (original files will be

deleted after compression)
· AU - updates existing files in the archive.

The default value is AA, which will be used if the "A"
parameter won't be specified in the command line.

P [ Password | 0 ]

 

Protects files with a password.

The default value is P0, which means that files will
be added to archive without being protected with a
password; a password will be applied only if you will
specify one after the "P" parameter. See the
example:

Pthisismypassword

"thisismypassword" will be used to protect the files
you are going to add through the command line.

F [ 0 | 1 | 2 | 3 ]
 

Tells the program how it should save the path of files
being compressed.

The "F" parameter may assume one of the following
value:

· 0 - just stores filenames without path info
· 1 - stores relative path
· 2 - stores full path without disk drive letter
· 3 - stores full path including disk drive letter

The default value F1, which is used when the "F"
parameter is not specified in the command line.
The F3 option must be used very carefully, because
it is useful just when you need to perform a real
backup of files and folders: when you will extract
files and folders that were stored using the F3
option, the program will ignore any destination
folder you will indicate and it will re-create the entire
path on your hard disk, just starting from the disk
drive letter. This options also may be not
compatible with other compression utilities.

R [ 0 | 1 ]

 

Sets program behaviour with subfolders while
compressing files.

"R" may assume one of the following value:

· 0 - ignore subfolders
· 1 - include subfolders

Default value is R0 and it is used when the "R"
parameter is not specified in the command line.

K [ 0 | 1 ]
 

Shows a progress indicator while performing an
action.

"K" may assume one of the following values:

· 0 - no indicator
· 1 - indicator is visible

Default value is K1 and it is used when the "K"
parametere is not specified in the command line.
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I [ 0 | 1 ]

 

Sets the program to remove the A (archive) attribute
from file being compressed.

"I" may assume one of the following values:

· 0 - attribute not removed
· 1 - attribute removed

The default value is I0, which is used when the "I"
parametere is not specified in the command line.

D [ A | H | R | S | F | Z | X ]
 

Tells the program to include only the files that have
the specified attributes among those selected for
compression.

"D" parameter may assume one or more of the
follwoing values:

· A - archive file
· H - hidden file
· R - read-only file
· S - system file
· F - folder
· Z - file without attributes
· X - file with any attribute (except folders)

The "D" parameter can be followed by a combination
of the switches described above, so you can force
the program to consider files with different attributes
at once. Example: DAH, DHZ, DARS and so on.

The default value is DX, which is used when the "D"
parameter is not specified in the command line.

V [ A | { volume size } ]

 

Creates a multivolume archive on a set of removable
media; the size of each volume may be
automatically calculated upon the destination media
capacity, but you can force the program to write
volume with a specific size by using one of the
following switches after the "V" parameter::
· A - volume size automatically calculated
· vm720 - 720 KB circa
· vm880 - 880 KB circa
· vm1440 - 1.44 MB circa
· vm2880 - 2.88 MB circa
· vmEmail - 250 KB
· vmWeb - 750 KB
· vmCDR650 - 650 MB circa
· vmCDR700 - 700 MB circa
· vmCDR800 - 800 MB circa
· vmDVD5 - 4.7 GB circa
· vmDVD9 - 8.5 GB circa

Remember: if you are going to save volumes on
optical media like rewritable CD-ROMs or DVD-ROMs,
you must format them with the UDF filesystem.

If the "V" parameter is not specified, no volume will
be created.
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S [ A | { volume size } ] Creates an archive and splits it into smaller files. The
file parts will be created on your hard disk, so you
will be free to choose what to do with those files. The
size of file parts is automatically calculated upon or
you can choose a file size by specificing one of the
following switches after the "S" parameter:
· A - size is automatically calculated
· sm720 - 720 KB circa
· sm880 - 880 KB circa
· sm1440 - 1.44 MB circa
· sm2880 - 2.88 MB circa
· smEmail - 250 KB
· smWeb - 750 KB
· smCDR650 - 650 MB circa
· smCDR700 - 700 MB circa
· smCDR800 - 800 MB circa
· smDVD5 - 4.7 GB circa
· smDVD9 - 8.5 GB circa

E Creates a self-extracting archive.

Just specify this parameter to get a .zip archive
converted to .exe.

O

 

Creates an archive and lets you specify options
through a dialog. Just specify this parameter in a
command line to force the program to show the
compression options dialog, that will let you set
additional options through a visual interface.

 

 

Note:
You can create archives only in the following formats:
· ZIP
· JAR
· WAR
· EAR
· WMZ
· WAL
· DSFZ
· BSZ
· PCV
· MSKIN
· SXW
· SXC
· SXD
· SXI
· XPI
· STW
· STC
· STD
· STI
· CBZ
· CAB
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· SQX
· TAR
· TAZ
· TGZ
· TAR.GZ
· TAR.BZ2
· RPM
· GZ
· Z
· BZ2

Also, remember that not akk the options are available to all formats that
support file compression: when you use an unsupported option with a given
archive format, that option will simply be ignored.
 

 

Examples:

1) zg -add "C:\My Folder\Test.zip" +*.*
This is the minimum set of parameters required by the "-add" command.

2) zg -add test.zip +*.* -*.doc -?.txt
Test.zip will be created in the current folder and it will contain all files stored
in the same folder, except all .DOC files and any file with the .TXT extension.
All other default settings will be used.

3) zg -add test.zip CB +*.* -*.doc -?.txt
Like previous example, but here we are going to apply BRUTAL compression
level.

4) zg -add test.zip R1 +*.* -*.doc -?.txt
Like example (2) but this time we need to compress subfolders, too.

5) zg -add test.zip R1 +*.* -*.doc -?.txt -\SubFolder1\*.*
Like example (4) but we want to exclude the whole folder "SubFolder1" from
being compressed.

6) zg -add test.zip C5 R1 +"C:\My Folder\*.*"
Test.zip will be written to current folder and MEDIUM compression level will be
applied. Also we would like to compress ll files and subfolder in C:\My
Folder\ with their relative path (default value, so no parameter is specified).
Test.zip will have this file list:

file1.txt
file2.txt
file3.txt
SubFolder1\file_a.doc
SubFolder1\file_b.doc
SubFolder1\file_c.doc
SubFolder1\SubFolder2\file_A.doc
SubFolder1\SubFolder2\file_B.doc
SubFolder1\SubFolder2\file_C.doc

7) zg -add test.zip C5 R1 F2 +"C:\My Folder\*.*"
Like example (6) but this time we want to store the same files together with
their full path, so F2 parameter is specified.
Test.zip will have this file list:
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My Folder\file1.txt
My Folder\file2.txt
My Folder\file3.txt
My Folder\SubFolder1\file_a.doc
My Folder\SubFolder1\file_b.doc
My Folder\SubFolder1\file_c.doc
My Folder\SubFolder1\SubFolder2\file_A.doc
My Folder\SubFolder1\SubFolder2\file_B.doc
My Folder\SubFolder1\SubFolder2\file_C.doc

8) zg -add test.zip C5 R1 @"C:\Folder 1\Files.txt"
Like example (6) but this time we want to compress the files and folders
specified in a text file stored in the hard disk as C:\Folder 1\Files.txt, which
looks like:

C:\Folder 1\Files.txt

+*.*
-*.doc
-*.gif
-*.txt
+"C:\Folder 2\*.bmp"

The "@" parameter is useful when you need to repeat tasks using always the
same options with a file list that may be differ from time to time.

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Syntax:
-backup destination folder {options}

Overview:
Creates the backup of a folder.

Parameters:

Destination
(required)

This parameter specifies the destination path of
the backup you are going to produce.

Folder
(required) It specifies the folder to backup: this could be a

full filesystem path (ex.: "C:\My Folder"), or one
of the following placeholders that can be used to
backup special system folders:

· MUSIC - My Music folder (Windows XP
only)

· PICS -  My Pictures folder (Windows
2000/XP only)

· VIDEO - My Video folder (Windows XP
only)

· FAVORITES - Favorites folder

· DOCS - My Documents folder

https://www.helpndoc.com
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· DESKTOP - Desktop folder

· FONTS - Fonts folder

Options
· C - this switch enables files compression and

it must be associated to one of the following
values that specifies compression level:

o 0 - storage only (no compression)

o 1 - minimum compression, max speed

o 5 - medium compression, medium
speed

o 9 - max compression, low speed

o B - brutal compression, lowest speed

Default value is C0 (it is used if "C" is not
specified).

· D - adds date in YYYYMMDD format and time
to backup filename. "D" may assume one of
the following value:

o 0 - option NOT enabled

o 1 - option ENABLED

Default value is D0 and it is used when "D" is not
specified.

· U - enables files updating in an existing
backup archive. This parameter may assume
one of the following values:

o 0 - option NOT enabled

o 1 - option ENABLED

Default value is U0 and it it use if "U" is not
specified.

· K - show progress indicator or not. possible
values of "K" are:

o 0 - NO progress indicator

o 1 - progress indicator is VISIBLE

Default value is K1.

· P - protects the backup archive with a
password. You can enable this parameter by
specifying a password after "P".
Example: Pthisismypassword.

· +/- (file) - these parameters specify wichi
file(s) must be included/ecluded by
compression action. If none is specified, the
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program will include all files.

Examples:
1) zg -backup D:\ MUSIC
"My Music" folder backup will be stored to "D:\" as "music.zip". All files and subfolders
will be included and no compression will be applied.

2) zg -backup D:\ MUSIC +*.mp3 +*.wma
Like example (1) but only .MP3 and .WMA files will be added to the backup file.

3) zg -backup D:\ MUSIC CB +*.mp3
Like example (1) but only .MP3 files will be included and brutalcompression level will be
applied.

4) zg -backup "c:\Test\mybackup.zip" "C:\My Folder\"
"C:\My Folder" backup will be saved as "c:\Test\mybackup.zip". All filess will be
included and no compression will be applied.

5) zg -backup "c:\Test\mybackup.zip" "C:\My Folder\" -*.txt -*.doc
Like example (4) but files TXT and DOC will be ignored.

Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

Syntax:
-oerestore archive

Overview:
This command restores Outlook Express folders and messages that have been saved with
ZipGenius related backup feature. The program will extract the .DBX files in the folder
that Outlook Express is currently using for your idtentity. WARNING: any .DBX file
already existing will be overwritten.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

Syntax:

-extract archive destination {options}

This command extracts files from the specified archive.

Required parameters:
archive
This is the filename of the archive that you want to decompress - Example: C:\Test.zip

destination
This is the destination folder where files will get extracted to.
If you want to extract files in the same folder where your archive is stored, you must
specify the placeholder -curr.
NEVER LEAVE BLANK the destination parameter!
If you want to extract files to a special system folder, you can use one of the following
placeholder, that will be converted automatically to the related path in the filesystem:

· [CDR] : folder for CD burning features (Windows XP)
· [DOCS] : My Documents folder
· [MUSIC] : My Music folder (Windows XP)
· [PICS] : My Pictures folder (Windows 2000/XP)
· [VIDEO] : My Video folder (Windows XP)
· [FAV] : Internet Explorer favorites folder
· [SYS] : Windows System folder (\Windows\System or \Windows\System32,

depending from Windows version)

https://www.helpauthoringsoftware.com
https://www.helpndoc.com
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· [WIN] : Windows folder
· [TEMP] : Windows temporary folder
· [CURR] : current folder
· [DESKTOP] : Desktop folder
· [PPC] : ActiveSync® synchronization folder

The placeholders listed above can be inserted in a path, like the following example:

[desktop]\Fold_1\Fold_2\Fold_3\

(in Windows 98) will become:

C:\Windows\Desktop\Fold_1\Fold_2\Fold_3\

and files will get extracted to subfolder Fold_3.

Options:

R[ 0 | 1 ]

 

This parameter allows to extract files from
subfolders stored in the archive with a
recursive scan.

"R" possible values are:

· 0 - subfolders are NOT extracted
· 1 - subfolders ARE extracted

The default value is R0 and it will be
selected if the "R" parameter is not
specified.

P[ Password | 0 ] This parameter allows to specify the
password that must be used in order to
decompress the archive.

If "P" is followed by a password, that will
be used by the program to decrypt the
files being extracted; if the password
supplied doesn't match the required one,
the program will ask to user for a new
password. The password may be asked
again if some file has not been encrypted
with the supplied one.

 

F[ 0 | 1 ] Restore paths in the destination folder.

"F" possible values:

· 0 - paths will be ignored
· 1 - paths will be rebuilt in the

destination folder

Default value is F1 and it will be selected
automatically if "F" is not specified.

N[ 0 | 1 ] This parameter creates a subfolder in the
destination folder and labels it after
archive filename.

Possible values of "N" are:

· 0 - option DISABLED
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· 1 - option ENABLED

Default value is N0 and it will be
automatically selected if "N" is not
specified in the command line.

O[ 0 | 1 | 2 ] Sets the program behaviour when it is
going to extract files that already exist in
the destination folder.

Possible values of "O" are:

· 0 - always overwrite existing files
· 1 - skip files
· 2 - ask user

Default value is O2 and it will be
automatically selected if "O" is not
specified in the command line.

 

+file

 

This parameter specifies which files (or
group of files) must be included in the
extraction procedure. It is possible to
specify also filenames with wildcards
like * and ? .

If the command line misses this
parameter, then all files will get extracted
from the specified archive.

-file This parameter specifies which files (or
group of files) must be excluded from
the extraction procedure. It is possible to
use filenames with wildcards
like * and ? .

If the command line misses the "-"
paramatere, then no file will be excluded.

@(files list) If you need to specify multiple files to
include and/or exclude from the
extraction procedure, then you can use
the "+" and the "-" parameters in a text
file, and you can drive the program to
read that list through this parameter: you
just have to specify the path and filename
of the text file that contains the list of
files being processed.

The text file should have a structure like
the following one:

+file > Include file
-file > Exclude file

D[ A | H | R | S | Z | X ]
  Sets the program to extract just files that

have specific attributes. It is possible to
specify one or a combination of the
following attributes:
· A - Archive file
· H - Hidden file
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· R - Read-only file
· S - System file
· Z - File without attributes
· X - Any attribute (this value

overrides all the others)

The default value is DX and it will be
automatically selected if "D" is not
specified in the command line.

Created with the Personal Edition of HelpNDoc: Free PDF documentation generator

Syntax:

-delete archive {options}

This command deletes one or more files from an archive.

Required parameters:

archive - filename of the archive that contains the files to be deleted. 

Options:

R[ 0 | 1 ]
 

This parameter searches for files to delete also in subfolders
stored in the archive.

Possible values of "R" are:

· 0 - option DISABLED
· 1 - option ENABLED

The defaut value is R0 and it will be automatically selected if "R"
is not specified in the command line.
 

+file
 

This parameter specifies which files should be considered for
deletion from the archive. It is possible to specify filenames with
wildcards like * and ?.
If this parameter is not specified in the command line, the
program will delete all files and the archive itself.
 

-file
 

This parameter allows to specify which file must be excluded
from a mass deletion action (e.g.: "+*.*" has been specified).
 

D[ A | H | R | S | Z | X ]
 

This parameter allows to delete just files that have given
attributes. "D" must be followed by one or by a combination of
the following attributes:
· A - Archive file
· H - Hidden file
· R - Read-only file
· S - System file
· Z - File without attributes
· X - Any attribute (this option overrides all the other

attributes)

The default value is DX and it will be automatically selected if

https://www.helpndoc.com
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"D" is not specified in the command line.
 

K:0 | 1 Shows a progress indicator while performing an action.

"K" may assume one of the following values:

· 0 - no indicator
· 1 - indicator is visible

Default value is K1 and it is used when the "K" parametere is not
specified in the command line.
 

 

WARNING:
Remember to use the "+" parameter to delete single files from an archive: if your command line
misses this parameter, all files will be deleted and the archive will become unreadable.

Created with the Personal Edition of HelpNDoc: Produce Kindle eBooks easily

Syntax:

-destroy archive

This command deletes an entire archive.

Example:

zg.exe -destroy arctest.zip

Created with the Personal Edition of HelpNDoc: Free EPub producer

Syntax:

-print archive

This command prints the file list of an archive.

Example:

zg.exe -print arctest.zip

Created with the Personal Edition of HelpNDoc: Free iPhone documentation generator

Syntax:

-export archive format destination [-Q]

This command exports the file list of an archive to the specified type of file.

Required parameters

archive

The filename of the archive whose file list you want to export.

https://www.helpndoc.com/feature-tour/create-ebooks-for-amazon-kindle
https://www.helpndoc.com/create-epub-ebooks
https://www.helpndoc.com/feature-tour/iphone-website-generation
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format

This parameter allows to specify the ecport format:

· HTML: files list will be exported to a HTML page ready for the web (it will include file icons).

· CSV: files list will be exported to a comma-separated values file.

· XML: files list will be exported to a XML-based file.

· TXT: files list will be exported to a plain text file.

The optional -Q parameter can be used to suppress the confirmation message that appear at the

end of the whole procedure.

Example 1 - arctest.zip files list will be exported to a Web page on the Desktop (in Windows 98):

zg.exe -export "C:\Test\arctest.zip" HTML "c:\Windows\Desktop"

Example 2 - arctest.zip files list will be exported to a XML file but the program will ask user for a

destination folder:

zg.exe -export "C:\Test\arctest.zip" XML

Created with the Personal Edition of HelpNDoc: News and information about help authoring tools and
software

Syntax:

-mail archive1 [archive2 ... archiveN]

Sends one or more archive via e-mail as attachments to a message.

Example:

zg.exe -mail arctest.zip

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

· Syntax 1:

-sfx -template

· Syntax 2:

-sfx archive {options}

This command allows to create a self-extracting archive from an existing ZIP archive. This

command has a wide set of options that are the same you can find in the SFX wizard of

ZipGenius.

The first syntax of this command writes a template options file on the desktop, so you can easily

https://www.helpauthoringsoftware.com
https://www.helpauthoringsoftware.com
https://www.helpndoc.com/help-authoring-tool
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modify that upon your requirements and use it through the "@" parameter (as explained below); on

the contrary, the second syntax is the true command line syntax where you can directly specify

which options should be used while converting the ZIP file to EXE.

An option file is a plain text file (with .SOF extension) that contains the following settings: it is

useful when you need often to convert a ZIP file to EXE, because you can reuse it at anytime you

need.

.SOF options file parameters

Title

the title of your SFX, it will appear on top of its window

MsgType

Type of message you want to show when your SFX is launched (see below).

0 - simple message (only "OK" button)

1 - information ("OK" and "Cancel" buttons)

2 - confirmation (Yes" and "No" buttons)

MsgText 

Text of the message you may want to show upon SFX startup. Leave blank if you

don't want any message to appear.

Autorun

0 - FALSE: no file is automatically launched after extraction

1 - TRUE: file autorun enabled, see also RunFile and AskAutorun.

RunFile

This setting lets specify the full path of the file that the SFX should run after

extraction. Example: RunFile="\Test\Testfile.exe", or: RunFile = "Setup.exe". If

you want to run a file that has been stored with path information, the path must be

specified as you can see in the first example. It is suggested to write paths

between quotes (").

AskAutorun

0 - FALSE: the end user won't be allowed to disable the autorun of a file

1 - VERO: a checkbox in the SFX dialog will allow the end user to disable the autorun

of a file

DestPath

Write here the default destination path where files in the archive should be extracted

to. Further details on destination path: Creating a self-extracting archive.

DestSubPath

Creare_files_autoestraenti__SFX_.htm#Destinazione predefinita
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If you want, you can create a subfolder in the destination path: write here the name of

the subfolder. Firther details: Creating a self-extracting-archive.

OvrType

This option sets program behaviour with files that already exists in the destination

path:

0 - ask user

1 - always overwrite existing files

2 - skip file

HideOvrBox

This option allows to hide the overwrite behaviour selector from the SFX dialogs:

0 - FALSE: overwrite mode selector will appear

1 - TRUE: overwrite mode selectore will be hidden

SelectFile

This option allows end-user to select files to extract from the SFX archive:

0 - FALSE: end-user won't be allowed to select files

1 - TRUE: end-user will be allowed to select files

ShowSuccessMsg

This option can force the SFX archive to show a "success message" after files

extraction:

0 - FALSE: no message will appear after extraction

1 - TRUE: the success message will appear

ExpandEnvVars

This option will force the SFX to translate environment variables in "%...%" form

written in the destination path (DestPath):

0 - FALSE: variables won't be translated

1 - TRUE: variables will be translated (recommended)

HideFileList

This option will force the SFX to hide/show the file list:

0 - files list will be visible

1 - files list will be initially hidden (end-user will have to click on "Show files" to see it)

2 - files list will be hidden

AllowCancel

This option will allow end-user to abort files extraction:

0 - FALSE: end-user won't be allowed to cancel extraction

1 - TRUE: end-user will be allowed to cancel extraction

Creare_files_autoestraenti__SFX_.htm#Sottocartella di destinazione
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Icon

If you want to customize the main icon of your SFX archive, you can specify here the

path to an .ICO (icon) file. Remember to write this path between quotes ("). If you

leave this field blank, the SFX archive will show its default icon.

The alternate way to convert a ZIP file to an executable one, is to use the second syntax of -SFX;

in this case you can specify more options and you can still use an existing options file (.SOF). The

parameters you can specify for -SFX command are similar to those you can specify for -ADD.

W(path) This parameter lets you specify the .BIN module you want to use to do

the conversion. SFX modules (.BIN files) differ for the language used in

the dialogs.

It is possible to specify the path to a custom SFX module or you can use

one of the .BIN files installed by ZipGenius: you just have to use (or to

not use) the # character before the .BIN filename:

· W#italiano.bin will force the program to use the "italiano.bin" file

installed by ZipGenius;

· Witaliano.bin will set the program to use the "italiano.bin" file that

should be placed in our current directory.

If you want to know which .BIN files are available,  use the following

parameter (all other switches will be ignored): W?

If the specified .BIN file can't be found, the program will automatically

use the english.bin installed by ZipGenius.

 

N(text) If you want to show a message upon SFX startup, use "N" followed by

your message (see example below); if you don't want any message to

appear, just omit this parameter. Messages bust be inserted between

quotes ("). See also the "M" parameter.

Example:

N"This is a very long message with spaces between. As you can see, it

is written between quotes."

 

M[ 0 | 1 | 2 ] If you have used the "N" parameter to show a message on SFX startup,

you can also set which type of message to show by setting one of the
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following values for "M":

· 0 - basic message (only "OK" button)

· 1 - information ("OK" and "CANCEL" buttons)

· 2 - confirmation ("YES" and "NO" buttons)

The default value is M0 and it will be automatically selected if "M" is not

specified. Also, this parameter will have no effect if your command line

misses the "N" parameter.

 

T(title) This parameter lets you specify the title for your SFX dialog. If "T" is not

specified, a generic title will appear on top of your SFX dialog.

 

L[ 0 | 1 ] This parameter will allow end-user of the SFX to select which files to

extract.

Possible values for "L" are:

· 0 - option DISABLED

· 1 - option ENABLED

If not specified in the command line, the program will automatically set

this parameter to L0.

 

B[ 0 | 1 ] This parameter lets you set the visibility of the overwrite mode selector

box in the SFX dialog. The end-user of your SFX won't be allowed to set

the behaviour that the SFX must have when it is going to extract files

already existing in the destination path.

Possible values of "B" are:

· 0 - overwrite mode selector HIDDEN

· 1 - overwrite mode

If not specified, this parameter will be automatically set to B0.

 

O[ 0 | 1 | 2 ] This parameter lets you set the overwrite mode that SFX must apply

when it is going to extract files that already exists in the destination path.

If it is used when "B1" is specified, the end-user won't be allowed to

modify the overwrite mode.
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"O" may assume one of the following values:

· 0 - ask user

· 1 - skip file

· 2 - overwrite file without confirmation

If not specified, this parameter will be automatically set to O0.

 

D(path /

registry key)

This parameter lets you specify the default extraction path that will

appear in SFX dialog window. The "D" parameter may be followed by a

real path name, by a Windows Registry key that returns a path or by an

environment variable in the "%...%" form.:

· Filesystem path

Ex.: "C:\My Folder\"

· Windows Registry Key

Ex.:

"HKCU\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell

Folders\Desktop"

· Enviroment variable in "%..%" form

Ex.: "%windir%"

While the first form of path is quite simple to specify, it is just useful

when your SFX is going to be used by yourself or by someone whose

computer has a path structure that you already know.

On the contrary, if you want to get your files extracted in specific paths

that are common to every Windows but that may be "phisically" different,

you can use the other two forms. These usually require a good

knowledge of Windows® operating systems and its registry structure, but

you can still find more details in "Creating a self-extracting archive"

section.

 

U(folder

name)

This parameter lets you specify the subfolder where your files will get

extracted to. The folder will be created in the path specified through the

"D" parameter.

 

V[ 0 | 1 ] This parameter lets you specify whether your SFX archive should

Creare_files_autoestraenti__SFX_.htm#Destinazione predefinita
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expand "%...%" environment variables written in the "D" parameter.

Possible values of "V" are:

· 0 - option DISABLED (variables won't be expanded)

· 1 - option ENABLED

Default value of "V" V1 and it will be used if "V" won't be specified.

 

H[ 0 | 1 |  2 ] This parameter lets you set the SFX files list visible or hidden or just

initially hidden.

Possible values of "H" are:

· 0 - files list visible

· 1 - files list initially hidden

· 2 - files list hidden

Default value is H0.

 

A[ 0 | 1 ] This parameter lets you set the SFX to autorun files extraction without

user interaction.

Possible values are:

· 0 - autorun DISABLED

· 1 - autorun ENABLED

If not specified in the command line, the program will use the default

value (A0).

 

I(.ICO file

path)

This parameter lets you specify the path of the custom icon you may

want to show in the SFX dialog window. The icon file must be

an .ICO file.

 

C(file) This parameter lets you specify which file must be executed after files

extraction.

 

K(command

line

parameters)

This parameter lets you specify additional parameter to run the file

specified in "C". You should used quotes (") to write long command

lines.
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S[ 0 | 1 ] This parameter lets you set your SFX to show a "success message" after

files extraction.

Possible values are:

· 0 - DO NOT SHOW success message

· 1 - SHOW success message

Default value is S1.

 

R[ 0 | 1 ] This parameter lets you set your SFX archive to allow end-user to

disable the autorun of a file after extraction (see parameter "C" ).

Possible values are:

· 0 - opzione DISABLED

· 1 - opzione ENABLED

Default value is R0.

 

E[ 0 | 1 ] This parameter lets you allow your SFX end-user to abort extraction.

Possible values of "E" are:

· 0 - user CANNOT ABORT extraction

· 1 - user IS ALLOWED to abort extraction

The default value is E1.

 

@(file .SOF) This parameter tells to the program to load SFX settings from a

previously stored .SOF file (a ZipGenius SFX options file). Any other

parameter will be ignored in this case.

 

Examples:

1) zg -sfx test.zip

This is the minimum number of parameters required by -sfx: test.zip will be converted

to test.exe and just using all the default parameters values.
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2) zg -sfx test.zip W#italiano.bin T"This is my archive SFX" S0

Like example (1), but this time we are going to use the italian .BIN file installed by ZipGenius, a

message will appear at SFX startup and no message will appear after files extraction.

Created with the Personal Edition of HelpNDoc: Easily create iPhone documentation

Syntax:

-optim filename -PM

This command optimizes OpenOffice.org documents compression.

Options:

· P - shows a progress indicator.

· M - shows a message at the end.

Example:

zg.exe -optim "C:\Test\MyDoc.odt" -P

Created with the Personal Edition of HelpNDoc: Full-featured EBook editor

· Syntax 1:

-encrypt filename C|E S|L|D 0 P|N Key1 Key2 Key3 [AuthorName][AuthorMail]

· Syntax 2:

-encrypt filename C|E S|L|D 1|2|3 Passphrase [AuthorName] [AuthorMail]

This command lets you convert ZIP files into CZIP encrypted files. There are two syntaxes

because the first one only must be used when you want to encrypt the file using the CryptoZip

algorhythm (CZIP); the other one, instead, is used to encrypt a ZIP file through an algorhythm like

Blowfish, Twofish and Rijndael (AES).

The parameters must be written in the same order you see them in the syntax synopsis shown

above.

Archive Type:

· C - CZIP standard archive, ZipGenius (or compatible application) will be required to re-

open the file;

· E - Executable CZIP file, auto-decryption provided, it won't require ZipGenius (or

compatible application) to re-open it.

Archive protection:

https://www.helpndoc.com/feature-tour/iphone-website-generation
https://www.helpndoc.com/create-epub-ebooks
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· S - standard protection, unlimited number of chances to enter the pass key/phrase;

· L - self-locking file, it will lock itself after three wrong pass key/phrases;

· D - self-deleting file, it will destroy all internal data after three wrong pass key/phrases.

Encryption algorhythm:

· 0 - CZIP 2.1. Options for this algorhythm (Syntax #1):

o Progres indicator:

§ P - visibile

§ N - not visibile

o CZIP Numeric Key (xxxxx-yyyyy-zzzzz):

§ Key1 - first part

§ Key2 - second part

§ Key3 - third part

· 1 - Blowfish 128 bit *

· 2 - Twofish *

· 3 - Rijndael (AES) *

* Algorhythms #1, #2, #3 have just one specific option:

Passphrase - the phrase used to encrypt an archive: use quotes (") if the phrase has spaces

between words.

Ex.: my test phrase -> "my test phrase"

Optional information fields (common to all algorhythms):

· AuthorName - archive author name

· AuthorMail - archive author e-mail address

NOTE: if you use the "E" switch to create an executable CZIP archive then the program will

automatically choose the options required to produce a standard CZIP; in fact, due to technical

reasons, it is not possible to create self-locking/deleting executable CZIP files.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

ZipGenius can export files list in various formats:

· HTML - ZipGenius creates a HTML file (a Web page).

· CSV - ZipGenius creates a file readable by many database programs (comma separated

value).

· XML - ZipGenius creates a XML file.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
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· TXT - ZipGenius creates a plain text document.

 NORMAL MODE

· In "First Step Assistant" bar, choose an export option

· choose in which folder ZipGenius should create the resulting file.

Optionally you can use the “Export file list” item in the “Tools” menu..

EXPERT MODE

Expert users can click on “Export…” items in the “Other actions” section of the sidebar or their

equivalents in the "Tools" menu. In you haven't selected a favorite exportation format in the

options panel, the "Export file list" item will have a submenu with all export formats available; on

the contrary, if you have selected a favorite format, you won't see that submenu and clicking on the

same item will export the file list into your favorite format. 

Created with the Personal Edition of HelpNDoc: Easy CHM and documentation editor

Even if Windows today is more stable than earlier versions, a good backup is the best way to

protect your data and your work; that's why ZipGenius comes with a wide variety of backup options

that will fit your needs.

Backup features can be reached through the main menu of ZipGenius, which is organized in two

section.

BACKUP OPTIONS

Compress files

Check this item if you want to compress files being added to the backup archive.

Insert date and time in filename

This option adds the date and time of creation to archive filename. The resulting filename will be

look like: backupname_YYYYMMDD_HHmm.zip, where YYYY is the year, MM is the month, DD

is the day, HH is the hour and "mm" is the minute.

Update archive

Check this item if you need to add files to an existing backup archive and to update files that are

already into that.

CHOOSE BACKUP:

Folder...

This one allows to backup a folder of your choice.

https://www.helpndoc.com
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My Music folder

Choose this one to backup the "My Music" folder (Windows XP only).

My Pictures folder

This one allows to backup the "My Pictures" folder (Windows 2000/XP only).

My Video folder

This one allows to backup the "My Video" folder (Windows XP only).

IE Favorites

It allows to backup the Favorites folder of Internet Explorer.

Mozilla Firefox\Thunderbird Profiles

You can backup the settings and messages stored for one of the user profiles installed for Mozilla

Firefox or Thunderbird application. The backup also could be converted to self-extracting, so you

don't have to use ZipGenius to restore the profile it contains.

My Documents

This backups your "My Documents" folders and creates an archive named Documents.zip.

Windows folder

Backups your windows folder and creates an archive named Windows.zip.

System folder

Backups your "\Windows\System" folder and creates an archive named System.zip.

Windows Registry 

This does the backup of Windows Registry. ZipGenius will copy the

files "system.dat", "user.dat", "system.ini"  and "win.ini"  in a  ".cab" archive, compatible with

"ScanReg ". By this way you will have the chance to restore your registry settings in a while. The

resulting archive will be named "rb1000.cab" and it will be place in \Windows\Sysbckup.

In Windows 2000/XP this option is hidden due to security reason: in fact, if you try to manually

restore the registry files, Windows will recognize that as a security violation and it will force you to

re-install the operating system.

Outlook Express messages

This one ackups all Outlook Express 5/6 folders and creates an archive named  OE_bak.zip.

Windows Address Book
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This does the backup of your current Windows Address Book in an archive named WAB_bak.zip.

Fonts

This does the backup of Windows' fonts folder.

Custom folders backup

You can add an unlimited number of custom paths to the Backup menu: click on "Add/manage

custom backup folders". This feature allows you to have how many folders you want ready to be

put in a backup archive.

Created with the Personal Edition of HelpNDoc: Free EBook and documentation generator

OpenOffice and LibreOffice can produce documents based on the XML standard language and

they create an XML file for contents, one for style and so on. When they must save the whole

document, a zip file is created with all the XML and additional files needed by the document, then

the zip file gets a different file extension (e.g.: ".ODT" for Writer documents). The worst detail

about this beahviour is that they don't use the maximum compression level available in zip format,

so ZipGenius can fix this issue.

ZipGenius can extract the contents from such document file and it compress them back using with

the Brutal compression level. Thanks to this feature, Libre/OpenOffice documents will be 1-7%

smaller than before (that depends by certain conditions such as the number of picture files in the

document).

WARNING! Optimization feature can be also applied to encrypted Libre/OpenOffice

document but this may lead to data loss, so you must be sure that you are trying to

optimize a non-encrypted Libre/OpenOffice document before proceeding.

If you have enabled the support to LibreOffice/Libre/OpenOffice in the Options panel, then you

can optimize documents from the context menu: right-click on a document and select "Optimize"

in the context menu, in order to optimize that. If you use this method, ZipGenius will be able to

optimize more than one document at once (you have only to select multiple Libre/OpenOffice files

and right-click on them).

However, you can optimize these documents from ZipGenius because you can open them just as

you would do with standard zip files: click "Open" and choose a document. Now, if you have set

"NORMAL" layout, ZipGenius will check the document and if it isn't optimized yet, ZG will ask if you

want to optimize it. In "EXPERT" layout, on the contrary, you won't prompted for any action and you

https://www.helpndoc.com
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have to right-click in ZipGenius windows to choose "Optimize document" from ZipGenius popup

menu. Anyway you will get additional items in the First Step Assistant menu. One of these allows

to optimize all Libre/OpenOffice documents in a single folder.

When you optimize an Libre/OpenOffice document, ZipGenius stores a backup copy with ".BAK"

extension, so you may recover the original file; also, ZipGenius add a comment to the document

(it's a zip file comment): "ZG". This comment is used to check if the skin file has been already

optimized or not. Libre/OpenOffice resets that comment each time it updates a document.

Created with the Personal Edition of HelpNDoc: Create help files for the Qt Help Framework

WARNING! This feature is obsolete because neither WinAmp or Windows Media Player are

available anymore. Anyway, this features works just like the optimization for Libre/OpenOffice documents.

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

SEARCH FOR ARCHIVES

ZipGenius can search archives in your system, then it can open them or print the list of archives

found.

In "EXPERT" mode, you can click on the arrow beside the "Open" button and select

"Search Archives" from the dropdown menu

Now choose which file type you want to search for, in which unit or folder to look in. Click "Start"

to proceed.

FIND FILES IN AN ARCHIVE

ZipGenius allows searching for  a file in an archive through some criteria. This feature is really

useful when you need to find an archive in large archive. You can activate this feature through the

"Panels" > "Find file" button of the sidebar. You have only to set search criteria:

· Begins with…. : search files that have an initial sequence of characters in their filenames

equal to the one you specify;

· Equal to: search files which have their filenames equal to the one you specify;

· Ends with…: search files that have a final sequence of characters in their filenames equal to

the one you specify;

· Contains: search files that have filenames containing the sequence of characters you specify.

Click "Start" to proceed: ZipGenius will show a list of files that satisfy those criteria; if you double-

click on one of them, it will be marked in main file list.

https://www.helpndoc.com/feature-tour/create-help-files-for-the-qt-help-framework
https://www.helpndoc.com/feature-tour
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Created with the Personal Edition of HelpNDoc: Benefits of a Help Authoring Tool

ZipGenius now allows to open more than one archive at once through the "MultiOpen" feature.

Click on "Open" and choose multiple archives to activate it, and the program will open the first

selected archive; all selected archives will appear as tabs above the file list, so you can click on a

tab to open its related archive.

If you right-click on a tab, you will get a popup menu with the following items:

· Group archive into a single zip

This command creates a new zip file which contains all archives in the MultiOpen list.

· Melt archives into a single zip

This command melts the content of all archives in the MultiOpen list into a single zip.

Files will be organized in separate folders, each one with a name taken from original

archive. WARNING: for some types of archive you will need external programs, because

this feature is based on ZipGenius extraction capabilities.

· Close archive

This command closes current archive and removes it from MultiOpen list.

· Close all archives

Closes all archives and clean MultiOpen list.

· Extract all...

This command decompress all open archives to the same folder, grouping files into

subfolders each represting an archive.

Plus, if you are using ZipGenius in expert mode, you will also get:

· Archive properties

· Rename archive

· Copy to...

· Move to...

· Delete current archive

These items are the same items you find in the "File" menu of ZipGenius.

If you have open a single archive, you can activate MultiOpen through the dropdown menu

attached to the "Open" button, by clicking on "Add archive to MultiOpen List": you will prompted

https://www.helpauthoringsoftware.com
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to select one or more archives to add to MultiOpen list; when you will choose some archives to

add, the related tabs will be added.  

Moreover, ZipGenius has been redesigned to be used with just one instance of the program, so if

you are in MultiOpen mode and you click on an archive in Windows Explorer, ZipGenius will add

that archive to the tab list.

In MultiOpen mode you can copy files from any archive to one or all zip files open. Select one or

more files and right-click to see the popup menu, which will show a new item labeled "MultiOpen

Actions" with these two functions:

· Copy file to... - this item will show all zip files open in a submenu: click on one of them

to copy the selected file to that.

· Copy to all open archives - this item will copy selected file to all open zip archives.

Created with the Personal Edition of HelpNDoc: Easy EPub and documentation editor

ZipGenius features can be extended throught the ZGTools, which are small applications that can

be used as standalone programs or as extensions for ZipGenius; there are few ZGTools at this

moment, but others are planned. One of this is shipped within the SUITE edition of ZipGenius,

others can be downloaded from ZipGenius website.

Currently available ZGTools are:

· Cutter  (available in Suite edition)

· Time To Get!  (optional for all ZipGenius versions)  

M.Dev Software creates these ZGTools but every software developer may create his own ZGTools

to be installed in ZipGenius ( see how to do that  ).

Installing ZGTools is very easy because those made by M.Dev Software have their own setup

program: when a ZGTool is installed, its item(s) will appear under the ZipGenius "Tools" menu.

 

Created with the Personal Edition of HelpNDoc: Easily create Web Help sites

The SUITE edition of ZipGenius includes the so-called ZGTools ,small programs that can works

both independently or together with ZipGenius. These ZGTools are made by M.Dev Software, but

other parties can create them, too.

To make ZipGenius to recognize a ZGTool, this last must communicate its presence in

https://www.helpndoc.com
https://www.helpndoc.com/feature-tour
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the TOOLS.INI file, which is placed in the folder where ZipGenius is installed.

The ZGTools must write a section in this file, just as shown in the following example:

[Collector]
cmd=C:\COLLECTOR\COLLECTOR.EXE
caption=Collect archives
params=-zg
results=c:\windows\deskop\result.txt
fileopen=0
senadarcname=0
sendselected=0
sendall=0

This example shows all the required parameters to use in a section.

CMD

This parameter tells the full path of the ZGTool to ZipGenius

CAPTION

Write here the caption of the item in the "Tools" menu that ZipGenius wil create for the ZGTool.

PARAMS

Write here additional parameters to the command-line. See

also SendArcName, SendSelected e SendAll .

RESULTS

If the ZGTools write a result file, this parameter tells to ZipGenius the path to this file; the main

program will show it in its internal editor.

FILEOPEN

This parameter tells if the ZGTool can be used only if an archive is opened in ZipGenius: "1" means

"true", "0" means false (the ZGTools can be called always).

SENDARCNAME

If this value is set to "1", the filename of the archive currently opened in ZipGenius is added to the

command-line.

SENDSELECTED

If this value is set to "1", all the archived files that are selected in ZipGenius window will be added

to the command-line.

SENDALL

If this value is set to "1", all the files listed in ZipGenius window will be added to the command-

line. 
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Tips for the developer:

1. If you need to know where tools.ini is placed, your ZGTool must read a key in Windows

Registry:

HKEY_CURRENT_USER\Software\M.Dev Software\ZG5

In these keys you will find the AppPath string value where the installation path of ZipGenius is

stored. That's the path of tool.ini, too.

2. You can create more than one section in tools.ini if your ZGTool does more than one job: you
have only to provide a section for each action. Example:

[Collector_1]
cmd=C:\COLLECTOR\COLLECTOR.EXE
caption=Collect archives
params=-zg
results=c:\windows\deskop\result.txt
fileopen=0

[Collector_2]
cmd=C:\COLLECTOR\COLLECTOR.EXE
caption=Collect ZIP and CAB archives
params=-zg-zip -cab
results=c:\windows\deskop\result.txt
fileopen=0

3. Be sure that the uninstall program of your ZGTool removes the related sections

from  tools.ini , and that this file won't be accidentally removed.

4. The ZGTool can be also a script: VBScript, JavaScript and .BAT or .COM files.

5. If your ZGTool creates a result file, make sure that the file begins with the name of the ZGTool,

your name, and your e-mail addrees or the address of your homepage. Do this because the

internal editor of ZipGenius can recognize hyperlinks.

6. In a short round of time, it will be available a small utility that helps the subscription procedure

of the ZGTools, so check often ZipGenius website site.

7. Force your ZGTool to recognize the language used by ZipGenius, so it can add its menu item

with the right language.

 

For more info, contact M.Dev Software.

Created with the Personal Edition of HelpNDoc: Easily create Help documents

Just as many other zip programs, ZipGenius has a "Disk spanning" feature that allow to distribute

large zip files through a set of floppy disks or similar; however that feature applies only to zip files,

so ZipGenius offers a second way to divide large files (of any type) into smaller parts: just

use Cutter, the ZGTool shipped within SUITE edition of ZipGenius. You can choose the feile to

mailto:zginfo@zipgenius.it
https://www.helpndoc.com/feature-tour
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split, how much large should be the resulting file parts and where you want to save them. When

Cutter will have finished its work, you will find a new subfolder in the destination path, where you

will find all the file parts produced by Cutter and a batch procedure (a .BAT file) that will rebuild the

original file on end user's PC. This ZGTool is completely wizard-driven.

If you want a newer version than the one shipped within ZipGenius Suite Edition, you could check

Cutter 5.

Created with the Personal Edition of HelpNDoc: Easily create Qt Help files

ZipGenius has been designed to offer better integration with the Internet. Internet related features

are:  

SEND AS ATTACHMENT.

You can:

· send an entire archive to someone by clicking on "Send as attachment" > "Archive":

ZipGenius will launch your default e-mail client and you will be able to compose a new e-mail

message which has an archive as attachment;

· send just one or more files extracted from the archive by clicking on "Send as attachment" >

"File": ZipGenius will create a new e-mail message which will have all selected files as

attachments.  

PUBLISH TO WEB.

You can upload an archive or just some files to a FTP server over the Internet. You can use this

feature only is FTPGenius is installed and you have to behave just as you would do to send an

attachment via e-mail (see above).

 

Created with the Personal Edition of HelpNDoc: Free Web Help generator

FTPGenius is ZipGenius FTP client. It can be used as a stand-alone application because it has a

link in the start menu. FTPGenius XP doesn't have an online help anymore because it reached its

EOL and it will be dismissed soon.

Created with the Personal Edition of HelpNDoc: Full-featured multi-format Help generator

There are two groups of files: "Binary" and "ASCII" files. A file of the first type is a sequence of "0"

and "1", while the second kind is pure text. Sometimes you can't send a binary file to a

FTP server over the Internet, because its administrator has denied access to binaries for safety

https://zipgenius.com/cutter-5/
https://www.helpndoc.com/feature-tour
https://www.helpndoc.com
https://www.helpndoc.com/help-authoring-tool
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reasons. The question is: how can you do to send a binary file also if it isn't accepted? You can

encode it!

You can choose three kind of encoding:

UUencode: it's the oldest type and it was born on UNIX systems. It produces files

with .uu or .uue extension, while ZipGenius produces only .uue files.

XXencode: very similar to the previous one, but it is considered as an evolution of it because it

fixes some issues on ASCII table conversion. ZipGenius will produce .xxe files.

MIME Base 64: actually this method is the most spread because it's used by e-mail servers and

programs. The files encoded with this system have the  .mim  and .b64 .b64 extensions.

You can encode an archive by opening the "Actions" menu, then choosing one of the three

methods.

Created with the Personal Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Click on a question to read the related answer.

1. How can I open a file?

2. How can I compress files?

3. Which file types does ZipGenius support?

4. How can I extract files from an archive?

5. What is an "archive"?

6. What is the "First Step Assistant"?

7. How can I backup a folder of my choice?

8. How can I backup pictures, video, music files and similar?

9. Why only Windows XP® users can extract to a CD-ROM burner?

10. Does ZipGenius handle ISO image files?

11. How can I customize ZipGenius window?

12. I need to install ZipGenius on more than one computer: how can I export settings to other

PCs?

13. Why ZipGenius can't be installed under Windows 95 or NT4.x anymore?

14. Is ZipGenius really free? Even for corporate users?

15. I want to pay to use ZipGenius: how can I send you my money?

16. Someone asked me money to download ZipGenius: is he/she authorized to do so?

17. What are ZGTools?

https://www.helpndoc.com/help-authoring-tool
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18. How can I build a batch file to automate ZipGenius actions? Any sample code?

19. I have more than one PocketPC® device synchronized with my desktop PC...

20. Why sidebar sometimes draws slowly?

21. Which are the size/file limits for ZIP format?

22. How can I make a slideshow?

23. How OpenOffice.org docs optimization works?

24. What is the "file marker"?

 

How can I open a file?

You can open a file in many ways:

· Click the "Open" button in ZipGenius and choose a file throught the open file dialog

· Drag and drop a zip file over ZipGenius link on the desktop

· Right-click a zip file and choose "Open" from the context menu (but only if ZipGenius is

associated to zip files)

How can I compress a file?

File compression procedure varies depending by the archive format you choose. Let's suppose

you want to compress file in a zip archive:

1. If the zip file must be created, click "New" and indicate path and filename for the new zip

file; otherwise go to next step.

2. Click "Add files" if you want to add just files, or "Add folder" if you want to compress the

content of a folder.

3. You will see a dialog ("Compression option") where you can set many options

(see: Compression options).

4. Click "Proceed" and wait until the action completes.

Which file types does ZipGenius support?

ZipGenius supports many archive types: read the full list.

How can I extract files from an archive?

You can extract files in many ways:

· Open an archive in ZipGenius and click on "Extract".

· Drag and drop a file from ZipGenius to a folder or to the Desktop.

· Right-click on an archive and, if enabled, click on one of the "Extract" items.

For further details upon extraction, see: Extracting files and The context menu.
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What is an archive?

Compressed files are often recognized as "archives" just because they contain many files inside,

organized in folders and subfolders. You may imagine a compressed files as an archive, where you

can collect all data in a single place.

What is the "First Step Assistant"?

The "First Step Assistant" was a wizard in older versions of ZipGenius: it let you perform several

actions with just one click. Now it has been converted to a submenu of the "HOME" button and it

appears only when you choose NORMAL layout.

How can I backup a folder of my choice?

ZipGenius now has an entire menu for backup features. Click on "Backup">"Folder..." and choose

the folder to backup.

How can I backup pictures, video, music files and similar?

Open the "Backup" menu and choose what to backup.

Why only Windows XP® users can extract to a CD-ROM burner?

Windows XP® comes by default with CD burning features while previous version used to burn CD-

ROMs through appropriate applications. This allowed many new features related to CD burning,

because you can copy or move files to the CD-R/RW unit, which is the placeholder for a special

folder where Windows stores them waiting for the burning process to be activated by user.

ZipGenius uses this same feature: it extracts files and folders to that special location and user

needs only to start the process. However we are trying to invent something to enable this feature

also under Windows 98/ME and 2000.

Does ZipGenius handle ISO image files?

Yes, it does (experimental support, yet).

How can I customize ZipGenius window?

You can modify color scheme, fonts and appearance. Click on "Options" and go to the "Layout"

page, where you can modify these setting.

I need to install ZipGenius on more than one computer: how can I export settings to other

PCs?

This is a new feature. Click on "Options" and review all settings. If you are satisfied, click on

"Export Settings". ZipGenius will ask you to select a location where to store the .REG file it is

going to create; copy that file on a removable media (floppy disk, CD-R, Compact Flash, USB

storage device and so on) and you are ready to copy settings. To store them on a different PC, just
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double click on the .REG file and Windows will ask you to confirm to store info in Windows

Registry. Click "YES" and you're done.

Why ZipGenius can't be installed under Windows 95 or NT4.x anymore?

These older versions of Windows are going to be dismissed by Microsoft® and many ZipGenius

advanced features can cause crashes when the program runs in those environments.

Is ZipGenius really free? Even for corporate users?

Yes, it is.

I want to pay to use ZipGenius: how can I send you my money?

ZipGenius is freeware, even if you decide to donate money to

me: http://www.zipgenius.it/paypal.htm . The best move you could do is to donate to some charity

near you.

Someone asked me money to download ZipGenius: is he/she authorized to do so?

No, nobody is authorized to ask money for ZipGenius download. Please, report details about this

person to zginfo@zipgenius.it

What are ZGTools?

ZGTools are small programs that do many things and, optionally, they can extend ZipGenius rich

set of features. Everybody can build his own ZGTool. For more info, see: How to build a ZGTool?

How can I build a batch file to automate ZipGenius actions? Any sample code?

Use Notepad and write a text file with ZipGenius commands for the command line. See: How to

use ZipGenius from the command line. Finally, save that file with the .BAT extension. 

I have more than one PocketPC® device synchronized with my desktop PC...

Click "Options" and go to the "Mobile" page. You will find a dropdown list with all the PocketPC

devices found. Choose one and click "OK". 

Why sidebar sometimes draws slowly?

Did you try new video drivers? 

Which are the size/file limits for ZIP format?

A ZIP file used to contain max 65536 files and its max size was 4 GB, but ZipGenius now uses

ZipForge engine to handle ZIP files that go over those limits (Zip64 supported). You may

also consider using the .7z archive format.

How can I make a slideshow?

http://www.zipgenius.it/paypal.htm
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First of all, check if ZG Album is installed. Open the "Actions" menu: do you see a menu item

labeled "Make slideshow"? If not, launch ZipGenius setup again and install only ZG album, if you

have downloaded ZipGenuius Suite Edition; if you have ZipGenius Standard Edition, you can

download ZG Album from www.zipgenius.it.

There are two ways of making a slideshow:

1. Through Scan and Zip: acquire pictures from a TWAIN devices, just as explained

in Importing Pictures.

2. By choosing a folder: click on "Make slideshow" in the "Actions" menu, choose a folder,

write Album details and you're done.

How OpenOffice.org docs optimization works?

When OpenOffice.org stores its documents, it produces a bunch of XML files with different

functions (style, content and so on) and image files, if document has images. Finally it zips all these

files and changes the file extension to *.SX* (.SXW for Writer and so on); but OpenOffice.org

doesn't use the maximum compression level because reading these docs would be slower. And

you if you need to gain some extra KiloByte? Use ZipGenius, which can read and extract files from

OpenOffice.org documents. ZipGenius extract all the contents of OOo documents and re-zip them

using the Brutal compression level. Documents will be always working but you will have gained

some KB. Optimized OpenOffice.org documents are zip files with an OOo extension and "ZG" as

zip comment: this comment is used only by ZipGenius to recognize OOo already optimized

documents (OpenOffice.org writes a new zip file each time you save your document, so the zip

comment is automatically removed). 

What is the "file marker"?

You often open zip archives with hundreds of files inside and you are looking for just one file or for

files of a given type. You may force ZipGenius to mark them with different font colors, styles and

background color.
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